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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the
“Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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Preface

TRADEMARKS LPS-900™, Pocket-3D™, GR-3™, Topcon Tools™,
Modem-TPS™, Topcon® and Topcon Positioning Systems™ are
trademarks or registered trademarks of TPS. Windows® is a
registered trademark of Microsoft Corporation. The Bluetooth® word
mark and logos are owned by Bluetooth SIG, Inc. and any use of such
marks by Topcon Positioning Systems, Inc. is used under license.
Other product and company names mentioned herein may be
trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
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Terms and Conditions

You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.
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Preface

Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Enter Press or click the button or key labeled Enter.

Further information to note about the configuration,
maintenance, or setup of a system.

4
o
-
m

Supplementary information that can help you
configure, maintain, or set up a system.

Supplementary information that can have an affect
on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

|| D| 8|0
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Manual Conventions

_{ﬂ- Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
[ WARNING injury.
Under no circumstances should this action be
performed.
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Notes:
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Chapter 1

Introduction

The HiPer Ga/Gb receiver is a dual-frequency, GPS+ receiver built to
be the most advanced and compact receiver for the surveying market.
The receiver is a multi-function, multi-purpose receiver intended for
precision markets. Precision markets means markets for equipment,
subsystems, components and software for surveying, construction,
commercial mapping, civil engineering, precision agriculture and
land-based construction and agriculture machine control,
photogrammetry mapping, hydrographic and any use reasonably
related to the foregoing.

The HiPer Ga/Gb can receive and process the latest GPS and
GLONASS signal types, improving the accuracy and reliability of the
survey points and positions, especially under difficult jobsite
conditions, and reducing cost.

Figure 1-1. HiPer Ga/Gb Receiver

The dual-frequency and GPS+ features of the receiver combine to
provide a positioning system accurate for any survey. Several other
features, including multipath mitigation, provide under-canopy and
low signal strength reception. The receiver provides the functionality,
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Introduction

accuracy, availability, and integrity needed for fast and easy data
collection.

Principles of Operation

Surveying with the right GPS receiver offers users accurate and
precise positioning, a requirement for any surveying project.

This section gives an overview of existing and proposed Global
Navigation Satellite Systems (GNSS) and receiver functions so basic
operating principles can be applied.

GNSS Overview

Currently, the following three global navigation satellite systems
(GNSS) offer line-of-site radio navigation and positioning, velocity,
and time services on a global, all-weather scale to any user equipped
with a GNSS tracking receiver on or near the Earth’s surface:

* GPS - the Global Positioning System maintained and operated by
the United States Department of Defense. For information on the
status of this system, visit the US Naval Observatory website
(http://tycho.usno.navy.mil/) or the US Coast Guard website
(http://www.navcen.uscg.gov/).

* GLONASS - the Global Navigation Satellite System maintained
and operated by the Russian Federation Ministry of Defense. For
information on the status of this system, visit the Coordinational
Scientific Information Center website (http://www.glonass-
ianc.rsa.ru/).

e GALILEO - an upcoming global positioning system maintained
and operated by European Satellite Navigation Industries, a joint
venture of several European space agencies/companies working
closely with the European Space Agency. Unlike GPS and
GLONASS, this is a civil endeavor and is currently in the
development and validation stage. For information on the status
of this system, visit the European Satellite Navigation Industries
website (http://www.european-satellite-navigation-
industries.net).
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Principles of Operation

Despite numerous technical differences in the implementation of
these systems, satellite positioning systems have three essential
components:

» Space — GPS, GLONASS, and GALILEO satellites orbit
approximately 12,000 nautical miles above Earth and are
equipped with a clock and radio. These satellites broadcast
ranging signals and various digital information (ephemerides,
almanacs, time and frequency corrections, and so forth).

¢ Control — Ground stations located around the Earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.

e User — The community and military that use GNSS receivers to
calculate positions.

Calculating Absolute Positions

When calculating an absolute position, a stationary or moving
receiver determines its three-dimensional position with respect to the
origin of an Earth-Center Earth-Fixed coordinate system. To calculate
this position, the receiver measures the distance (called pseudo-
ranges) between it and at least four satellites. The measured pseudo-
ranges are corrected for clock differences (receiver and satellites) and
signal propagation delays due to atmospheric effects. The positions of
the satellites are computed from the ephemeris data transmitted to the
receiver in navigation messages. When using a single satellite system,
the minimum number of satellites needed to compute a position is
four. In a mixed satellite scenario (GPS, GLONASS, GALILEO), the
receiver must lock onto five or more satellites to account for the
different time scales used in these systems and to obtain an absolute
position.

Calculating Differential Positions

DGPS, or Differential GPS, is a relative positioning technique where
the measurements from two or more remote receivers are combined
and processed using sophisticated algorithms to calculate the
receivers’ relative coordinates with high accuracy.

P/N 7010-0816 1-3
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DGPS accommodates various implementation techniques that can be
classified according to the following criteria:

* The type of GNSS measurements used, either code-phase or
carrier-phase differential measurements

* If real-time or post-mission results are required. Real-time
applications can be further divided according to the source of
differential data and the communication link used.

With DGPS in its most traditional approach, one receiver is placed at
a known surveyed location and is referred to as the reference receiver
or base station. Another receiver is placed at an unknown location and
is referred to as the remote receiver or rover. The reference station
collects the code-phase and carrier-phase measurements from each
GNSS satellite in view.

* For real-time applications, these measurements and the reference
station coordinates are then built up to the industry standard
RTCM—or various proprietary standards established for
transmitting differential data—and broadcast to the remote
receiver(s) using a data communication link. The remote receiver
applies the transmitted measurement information to its observed
measurements of the same satellites.

* For post-mission applications, the simultaneous measurements
from reference and rover stations are normally recorded to the
receiver’s internal memory (not sent over communication link).
Later, the data are downloaded to computer, combined, and
processed.

Using this technique, the spatially correlated errors—such as
satellite orbital errors, ionospheric errors, and tropospheric
errors—can be significantly reduced, thus improving the position
solution accuracy.

A number of differential positioning implementations exist, including
post-processing surveying, real-time kinematic surveying, maritime
radio beacons, geostationary satellites (as with the OmniSTAR
service), and satellite based augmentation systems (WAAS, EGNOS,
MSADS).
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The real-time kinematic (RTK) method is the most precise method of
real-time surveying. RTK requires at least two receivers collecting
navigation data and communication data link between the receivers.
One of the receivers is usually at a known location (Base) and the
other is at an unknown location (Rover). The Base receiver collects
carrier phase measurements, generates RTK corrections, and sends
this data to the Rover receiver. The Rover processes this transmitted
data with its own carrier phase observations to compute its relative
position with high accuracy, achieving an RTK accuracy of upto 1 cm
horizontal and 1.5 cm vertical.

Essential Components for Quality Surveying
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors, and counteracts Selective
Availability (SA) signals the US Department of Defense
transmits with GPS signals.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher positioning accuracy.

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt, and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

* Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Receiver Autonomous Integrity Monitoring (RAIM) detects
faulty GNSS satellites and removes them from the position
calculation.

— Five or more visible satellites for only GPS or only
GLONASS:; six or more satellites for mixed scenarios.
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— Satellite Based Augmentation Systems (WAAS, EGNOS, and
so on) creates and transmit, along with DGPS corrections,
data integrity information (for example, satellite health
warnings).

— Current ephemerides and almanacs.

Conclusion

This overview simply outlines the basics of satellite positioning. For
more detailed information, visit the TPS website at
wWwWw.topconpositioning.com.

Receiver Overview

When power is turned on and the receiver self-test completes, the
receiver’s 40 channels initialize and begin tracking visible satellites.
Each of the receiver’s channels can be used to track any one of the
GPS and GLONASS signals. The number of channels available
allows the receiver to track all visible global positioning satellites at
any time and location.

An internal GPS+ antenna equipped with a low noise amplifier (LNA)
and the receiver’s radio frequency (RF) device are connected with a
coaxial cable. The wide-band signal received is down-converted,
filtered, digitized, and assigned to different channels. The receiver
processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
Also, broadcast navigation data are retrieved from the navigation
frame.

After the receiver locks on to four or more satellites, its absolute
position in WGS-84 and the time offset between the receiver clock
and GPS time are computed. This information and the measurement
data are stored in the receiver’s internal memory and can be
downloaded later onto a computer, then processed using a post-
processing software package. When the receiver operates in RTK
mode, raw data measurements can also be recorded into the receiver’s
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internal memory. This allows the operator to double check real-time
results obtained in the field.

Depending on your options, capabilities of the receiver include:
* Co-op tracking
* Multipath reduction

* Satellite based augmentation systems (WAAS, EGNOS, and so
forth).

* Adjustable phase locked loop (PLL) and delay lock loop (DLL)
parameters

* Dual-frequency modes, including static, kinematic, real-time
kinematic (RTK), and differential GPS (DGPS) survey modes
(DGPS modes include static, kinematic, and RTK)

* Auto data logging
* Setting different mask angles
* Setting different survey parameters

* Static or dynamic modes

Getting Acquainted

The HiPer Ga/Gb comes in a real-time kinematic (RTK) package with
two receivers, one as a Base Station and the other as a Rover Station
(also, refer to the packaging instruction card). Each receiver casing
allocates space for two non-removable, rechargeable batteries, a
Bluetooth wireless technology module, a dual-system receiver board,
and radio modem communications board.

The embedded radio board is configured with a Digital UHF
transceiver that has a 410 to 470 MHz frequency range and 12.5 kHz
channel spacing. The board provides 29 dBm (0.79 W) power output
for data transmission.

The HiPer Ga/Gb Base and Rover receivers are shipped with the most
commonly used settings for the radio modem. The Rover settings are
configured to match the Base settings.

P/N 7010-0816 17
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The frequency range of the modem depends on the country in which
the receiver is used: for North America, the frequency range is

410 to 470; for all other countries, contact your local distributor.
Other features include serial and USB data ports, a power port, and a
MINTER for viewing status and controlling data input/output. These
features are described on the following pages.

HiPer Ga/Gb Receiver

The HiPer Ga/Gb receiver’s advanced design reduces the number of
cables required for operation, allowing for more reliable and efficient

surveying. The casing allocates space for a Bluetooth® wireless
technology module, a multi-system receiver board, and a radio
modem communications board.

The HiPer Ga/Gb comes with a Digital UHF TX/RX radio modem.

Other features include three data ports, a power port, and a MINTER
for viewing status and controlling data input/output.

MINTER

The MINTER is the receiver’s minimum interface used to display and
control data input and output (Figure 1-2). The slant height measure
mark (SHMM) is used when measuring the height offset of the
receiver.

Power Reset Button
Button 4.1us LED l Battery LED
l\«b{ RESET
O] STAT O
s ©0O Of
O 2
C B c
Serial Ports
,/@ DK A 4 ]( D
Record LED Modem Status LED
FN Button Slant Height Measure Mark

Figure 1-2. HiPer Ga/Gb MINTER
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The Reset button causes a hard reset of the receiver and causes the
receiver to leave Zero Power Mode and return to Normal Mode.

respond to commands or does not charge the

@ Only use this procedure if the receiver does not
internal batteries (is in Zero Power Mode).

The Power button turns the receiver on and off.

The Battery LEDs display the power status for each battery:
* Green — indicates greater than 85% charge.

* Orange — indicates an intermediate charge.

* Red — indicates less than 15% charge.

discharged and no external power is connected, the
receiver goes into Zero Power Mode to prevent the
batteries from over discharging.

% When the internal batteries have completely

The pattern of blinks also indicates the source of power:

* Solid light — an external power supply is used, and the batteries
are not being charged.

* Blinking once a second — the batteries are being charged.

* Blinking once every five seconds — the receiver uses the internal
batteries for power.

* Not blinking — the receiver is in Zero Power Mode or the internal
batteries are discharged, and no external power is connected.

The STAT LED displays the status of tracked satellites.

* Red blink — receiver is on but is not tracking satellites or does not
have a solution.

* Green blink — receiver is on and tracking satellites; one blink per
tracked GPS satellite.

* Orange blink — receiver is on and tracking satellites; one blink per
tracked GLONASS satellite.

P/N 7010-0816 1-9
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The REC LED displays the data recording status. See “The FN
(FUNCTION) button” on page 1-11 for more information on REC
LED behavior when using the FN button.

* Green blinks — each blink indicates that data is being written to
the SD/MMC card.

* Solid Orange — indicates the receiver is changing modes.

* Orange blinks — indicates that the receiver is checking its internal
file system (after clearing the NVRAM or loading new firmware).
During this operation, the file system is not accessible for CDU
(control display unit) applications or for data recording. This
operation may require from fractions of a second to several
minutes, depending on the circumstances and the amount of
internal memory.

¢ Solid Red — indicates a fault condition with the receiver (no more
memory, no SD/MMC card inserted, a hardware problem, or an
improper OAF).
Table 1-2 on page 1-12 describes the REC LED status when using the
FN button.

The RX TX LED displays the status of the modem. Table 1-1
describes the LED colors and patterns for the different modems
available for the HiPer Ga/Gb receiver.
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Table 1-1. RX TX LED Indications

* No light — modem is turned off.

¢ Solid Red — the modem is in transmitter mode; the modem is
transmitting data.

¢ Orange flashes — the modem is in command mode. This mode
allows the operator to send/query commands to/from the
modem.

UHE Modem |I° Flashing Green — the modem is in receiver mode

¢ Solid Green — a radio link has been established; the modem is
ready to receive data

* Solid Green with Orange flashes — the modem is receiving data.

* Red flashes — a fault condition has been detected. Check the
condition of the radio modem’s antenna to ensure it is
undamaged, and is connected properly and securely. Also make
sure that there is nothing to interrupt the signal.

The BT LED indicates the level of activity at the Bluetooth wireless
technology communication link:

¢ Blue flashes — the Bluetooth module is on but no connection is
established.

* Solid blue light — the Bluetooth module is on and a connection
has been established.

* No light — the Bluetooth module is off.
The power button turns the receiver on and off.

The FN (FUNCTION) button switches the receiver between
information modes and post-processing modes, starts/stops data
recording, and changes the baud rate of the serial port to 9600. See
“MINTER Operation” on page 4-7 for more information. Table 1-2
on page 1-12 describes the REC LED status when using the FN
button.
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Table 1-2. FN (FUNCTION) key operations and REC LED Status

FN Key

REC LED

Status

When data recording is off, and the FN key is...

Not pressed

No light No data recording.
Orange blink | Internal file system test in progress.
Red No free memory; hardware problem with

data recording.

Pressed for < 1
second

If FN key mode is “LED blink mode switch”

Orange

Release to change information mode.

If FN key mode is “Occupation mode switch”

Orange

No function.

Pressed for 1-5
seconds

If FN key mode is “LED blink mode switch”

Green

Release to start data recording (post-
processing occupation mode undefined).

If FN key mode is “Occupation mode switch”

Green Release to start recording (Kinematic or
Static post-processing occupation mode).
Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function.

seconds

When data recording is on, and the FN key is...

1-12
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Table 1-2. FN (FUNCTION) key operations and REC LED Status (Continued)

seconds

FN Key REC LED Status
Red No free memory; hardware problem with
data recording.
If FN key mode is “LED blink mode switch”
Green Data recording started (post-processing
occupation mode undefined).
Not pressed If FN key mode is “Occupation mode switch”
Green Data recording started (Kinematic post-
processing occupation mode).
Orange Data recording started (Static post-
processing occupation mode).
If FN key mode is “LED blink mode switch”
Orange Release to change information mode.
Pressed for < 1
second If FN key mode is “Occupation mode switch”
Orange Release to toggle between Static and
Kinematic post-processing modes.
Pressed for 1-5 No light Release to stop data recording.
seconds
Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function (data recording still on).
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Data and Power Ports
The receiver has the following ports (Figure 1-3 on page 1-14):

* Two serial ports:

— Port A used for communication between HiPer Ga/Gb and a
controller or any other external device.

— Port B used internally to connect the receiver board with the
optional Bluetooth module.

affect the Bluetooth link. The default settings for
Port B are: 115200 bps, 8 data bits, 1 stop bit, no
parity, and no handshaking.

% Changing the receiver’s Port B default settings will

* PWR - The power input port to which an external power source
(+6 to +28 V DC) is connected and where the unit is charged.

* USB - Used for high-speed data transfer and communication
between the receiver and an external device.

* Slant height measure mark (SHMM).

B c
erial P ort
© T ;_T T T ©
Serial Ports A-D USB Power

Slant Height Measure Mark
Figure 1-3. HiPer Ga/Gb Ports
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External Radio Antenna Connector

The antenna connector on the receiver’s radome is a BNC connection

(Figure 1-4).

External
Antenna

Connector

Figure 1-4. Receiver Radome and External Antenna Connector

Cables

The HiPer Ga/Gb package includes standard communication and
power cables for configuring the receiver and providing a power
source to the receiver. Table 1-3 lists the cables included in the HiPer

Ga/Gb package.

Table 1-3. Package Cables

Cable Description

Cable lllustration

Power cable

Connects the power supply unit to a
grounded outlet.

U.S. p/n 14-008052-01

Europe p/n 14-008054-01
Australia p/n 14-008074-01

Receiver power cable
Connects the receiver and the
power supply unit via SAE
connectors.

p/n 14-008016-03

&
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Table 1-3. Package Cables (Continued)

Cable Description Cable lllustration

USB cable

Connects the receiver to an external
device (controller or computer) for
high-speed data transfer and
receiver configuration.

p/n 14-008031-01

Serial cable

Connects the receiver to an external
device (controller or computer) for
data transfer and receiver
configuration.

p/n 14-008005-03

Other Accessories

This package can include the following accessories.

The power supply unit (p/n 22-034101-01) charges the internal
batteries when connected to a grounded outlet (Figure 1-5). This unit
converts the alternating current (AC) normally supplied from an
electrical outlet to a direct current (DC) used to charge the batteries
and/or power the receiver.

The power supply unit should only be used for
charging the batteries. Do not use as a power source
during surveying.

The power supply unit connects directly to the receiver. For details,
see the power related sections on page 2-13.

Figure 1-5. Power Supply Unit
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The modem antenna supports UHF communication (Figure 1-6).
The UHF modem antenna is a BNC RF connection and comes in two
versions: 410—440 MHz (p/n 30-070003-01) and 440-470 MHz

(p/n 30-050503-01).

Figure 1-6. UHF Modem Antenna

For more details on the accessories and package options available for
the Hiper Ga/Gb, contact your local Topcon dealer.

The universal tribrach and tribrach adapter (p/n 22-006008-01
and p/n 22-006009-011) are used to level the tripod and secure the
receiver or antenna to the tripod (Figure 1-7).

Figure 1-7. Universal Tribrach and Tribrach Adapter

For more details on the accessories and package options available for
the HiPer Ga/Gb, contact the local Topcon dealer.

Optional Accessories

Topcon offers a wide variety of accessories especially designed to
extend job reliability and efficiency. For more details on the optional
accessories available for the HiPer Ga/Gb, contact the local Topcon
dealer.

The precision tribrach adapter (Figure 1-8) is used to precisely
center, align, and level the tripod over a point. The horizontal spacer
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(p/n 60419) inserts into the precision tribrach and allows the receiver
to sit securely on the precision tribrach.

Figure 1-8. Precision Tribrach Adapter and Horizontal Spacer

A hand-held controller (Figure 1-9) allows the HiPer Ga/Gb Base
and Rover systems to be configured and monitored directly in the
field. TopSURYV (field data collection software) and CE-CDU
(receiver configuration and monitoring software) can be used on
Topcon controllers to configure and manage the receiver.

# Topcon

FC-2000

cooof) 2°
%
@

00606

00060
o@@@@

]

0000
00000
00000
00000
00000
000
Qo000

|

Figure 1-9. Hand-held Controller Examples
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The ODU-to-alligator clips cable (p/n 14-008097-01LF) connects
the charging cradle or receiver to an auxiliary battery for powering the
receiver during survey operations (Figure 1-10).

Figure 1-10. Auxiliary Power Cable — ODU-to-Alligator Clips

The 2m fixed height Tripod and Pole 1.(22-050911-01 and 22-
050908-01). Pole not pictured. Tripod for the HiPer Ga/Gb
(Figure 1-11).

Figure 1-11. Tripod
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Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a predetermined period of time. When the receiver is
purchased, a new OAF permanently activates purchased options.
Receiver options remain intact when clearing the NVRAM or
resetting the receiver.

The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the TPS website at
www.topconpositioning.com or consult a TPS dealer.

* GPS and GLONASS signal types

» Receiver (optional) internal memory is up to 128 MB

* Position update rate standard 1Hz (optional 5, 10, or 20Hz)
e RTK at 1Hz, 5Hz, 10Hz, and 20Hz

* RTCM/CMR Input/Output

* Event marker

* Co-op tracking

* Advanced multipath reduction

 Satellite Based Augmentation System (WAAS, EGNOS, MSAS)
* 1 PPS (Pulse-Per-Second; a timing signal)

* Receiver Autonomous Integrity Monitoring (RAIM)
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Chapter 2

Pre-survey
Preparation

Before beginning to survey with the HiPer Ga/Gb receiver, the
following software needs to be installed and configurations need to be
applied:

O

O

Install receiver configuration software

See “Installing Topcon Software” on page 2-2.

Charge the batteries
See “Charging the Internal Batteries” on page 2-7.

Enable power source settings (either attached or external)

See “Power Management” on page 2-9 and “Powering the
Receiver with an External Battery” on page 2-13.

Configure the Bluetooth wireless technology module
See “Bluetooth Module Configuration” on page 2-17.

Collect almanacs and ephemerides (after first-time configuration
activities as described on page 2-21).

See “Collecting Almanacs and Ephemerides” on page 2-21.

This chapter also discusses connecting batteries to the receiver,
connecting the receiver and a computer, and powering the receiver
using different sources.
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Installing Topcon Software

The Topcon GPS+ CD includes the following software programs used
for configuring and maintaining the receiver. This software is also
available on the TPS website at www.topconpositioning.com to
registered users.

 PC-CDU Lite « BTCONF
ver. 2.1.15 or newer ver. 1.3 or newer
¢ Modem-TPS ¢ FlLoader
ver. 2.2p2 or newer ver 1.0.07 or newer

If installing the program(s) from the GPS+ CD, insert the CD into the
computer’s CD-ROM drive. If downloading the program(s) from the
website, extract the program’s files into a folder on the hard drive.

The following sections describe installing this software, and other
sections throughout the manual describe using this software with the
receiver.

Installing PC-CDU

PC-CDU™ js a comprehensive Windows® software product
designed for controlling GPS+ receivers developed by Topcon
Positioning Systems. PC-CDU uses the GPS Receiver Interface
Language (GRIL) to configure various receiver settings and diagnose
receiver performance.

The PC-CDU software exists in two versions: a full-functionality
version called PC-CDU MS and a reduced-functionality version
called PC-CDU Lite. PC-CDU Lite is available for free on the Topcon
website (www.topconpositioning.com) or the GPS+ CD.

Computer requirements for PC-CDU are: Windows® 98 or newer and
an RS-232C or USB port, or Bluetooth capable. Use PC-CDU version
2.1.15 or newer to correctly configure the receiver.

Refer to the PC-CDU Reference Manual for full
details on installing and using PC-CDU.
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To install PC-CDU:

1. Create a PC-CDU folder on the hard drive and place the
compressed PC-CDU zip file (retrieved from either the website or
the GPS+ CD) in this folder.

2. Navigate to the PC-CDU folder, and double-click the PC-
CDU_MS zip file.

3. Extract the PCCDU.EXE and associated *.dll file to the PC-CDU
folder (Figure 2-1).

4. Optionally, create a shortcut on the computer’s desktop for quick
access to PC-CDU (Figure 2-1).

File Edit View Favorites Tools  Help

G Back - () 7 ) search | [ Foders | [1T)-

Address | I3 C:itopeonipeedu v a Go

Folders X Name Size | Type Date Modified

B pesktop | Hpccou ms.zie B54KB WinZip File 14512004 4:56 PM #
® {5} My Documents [EPracces wo 6KE Virtudl devic...  §{1/2000 6:39 PM

= 9 My Computer £, PCCDULEXE 2,224KB  Application 12j23{2003 5:16 PM Izl-tl.’ll.l

® L 3% Floppy (A:)
B S New Volume (C:)
# I3 Documents and Settings
& ) Program Files
|2 guarantine
= TEme
= I3 topeon
3 peedu

1) unzipped
# 33 wINDOWS
® 2 CD Drive (1)
® L CD Drive (E1) o
> £ >

Figure 2-1. Extract Program and Create Shortcut

To uninstall PC-CDU, navigate to the location of the *.exe file. Select
the file, and press Delete.

Installing Modem-TPS

Modem-TPS is a configuration program for the radio modem board
inside the receiver. Modem-TPS is available from the TPS website
(www.topconpositioning.com) or on the GPS+ CD.

Computer requirements for Modem-TPS are: Windows® 98 or newer
and an RS-232C port or Bluetooth® wireless technology. Use
Modem-TPS version 2.2p2 or newer to correctly configure the
receiver.

P/N 7010-0816 2-3



Pre-survey Preparation

To install Modem-TPS:

1.

Navigate to the location of the Modem-TPS program, and double-
click the Setup.exe icon.

Keep the default installation location or select a new location.
Click Finish (Figure 2-2).

Modem-TPS Installation

Please enter the directory in which to instal
todem-TRS

Installing Files...

Extracting file to C:\Frogram Files\Modem-TPS it dil

Modem-TPS Directory:

C:“Program Files'\Modem-TPS Change

Finish |, Cancel |

Figure 2-2. Select Modem-TPS Installation Location and Install

3. Click OK to complete the installation (Figure 2-3).

4. Optionally, create a shortcut on the computer’s desktop for quick

access to Modem-TPS (Figure 2-3).

Modem-TPS Installation

Modem-TPS installation successiul

A IDEM

Figure 2-3. Installation Complete and Shortcut

To uninstall Modem-TPS, use the Start menu on the computer:

1.

Click Start » Programs » Modem-TPS » Uninstall Modem-
TPS, and click Yes at the prompt.

2. Click OK when the uninstall completes.
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Installing BTCONF

BTCONEF is a configuration program for the Bluetooth wireless
technology module inside the receiver. BTCONF is available from the
TPS website (www.topconpositioning.com) or on the GPS+ CD.

Computer requirements for BTCONF are: Windows® 98 or newer
and an RS-232C port or Bluetooth wireless technology. Use
BTCONEF version 1.3 or newer to correctly configure the receiver.

To install BTCONF:

1. Create a BTCONF folder on the hard drive, and place the
compressed BTCONF zip file (retrieved from either the website
or the GPS+ CD) in this folder.

2. Navigate to the BTCONF folder, and double-click the BTCONF
zip file.

3. Extract the btconf.exe to the BTCONF folder.

Optionally, create a shortcut on the computer’s desktop for quick
access to BTCONF (Figure 2-4).

& btconf E@E‘
Fle Edit View Favorites Toos Help o
Qe - Q- [F | O search |2 Foers | [FH-
Address |2 Crytopeon|bteonf v B
Folders X Name Size | Type Date Modified “
(@ Deskton | Slbtconf zip 273KE  WinZip File 8/17/2005 2:18 PM
# (L) My Documents 7 bteorf exe 554KB  Application 6/20/2003 10:23 AM M
= 4 My Computer
& Jd 3% Floppy (A @mﬁﬂ
= e New Volume (C:)
# [ Documents and Settings
# I3 Pragram Files
15 quarantine
1= TEMP
= I3 topeon
3 bteonf
3 pecdu
15 unzipped
H 3 WINDOWS
@ Lk CD Drive (D0 L/
< I >

Figure 2-4. Extract Program and Create Shortcut

To uninstall BTCONEF, navigate to the location of the *.exe file. Select
the file, and press Delete.

Each time BTCONF runs and configures the Bluetooth module,
BTCONEF saves the settings in a file (btconf.ini). BTCONF
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automatically updates the file each time changes are made to the
Bluetooth module’s settings.

different purposes, keep copies of BTCONF in

i : i To maintain unique Bluetooth module settings for
separate folders.

Installing FLoader

FLoader is a firmware loading program for the power board, GPS
module, and modem board inside the receiver. FLoader is available
from the TPS website (www.topconpositioning.com) or on the GPS+
CD.

Computer requirements for FLoader are: Windows® 98 or newer and
an RS-232C port or Bluetooth® wireless technology. Use FLoader
version 1.0.07 or newer to correctly configure the receiver.

To install FLoader:

1. Create an FLoader folder on the hard drive, and place the
compressed FLoader zip file (retrieved from either the website or
the GPS+ CD) in this folder.

2. Navigate to the FLoader folder, and double-click the FLoader zip
file.

3. Extract the FLoader.exe file to the FLoader folder (Figure 2-5).

Optionally, create a shortcut on the computer’s desktop for quick
access to FLoader (Figure 2-5).
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File Edt View Favorites Tooks  Help "
Q@ek - (0 (T O seanch | Foers | [T
Address | Critopeanifloader v B
Folders X Name Size | Type Date Modified
(@ Desktop w| CJ¥floader_spp.zip | 234KE  Winip File 8/17/2005 2:17 PM #
# (5] My Documents #F, Floader exe S24KE  Application 2i12{2002 5:49 PM E F I.
= My Computer
® L 3% Floppy (A2 ﬁlﬁ@iﬁ?
B S New Wolume (C:)
# I3 Documents and Settings
& [ Program Files
|2 quarantine
1) TEMP
= 1) topcon
(23 bteonf
2 floader
3 predu
| unzipped
# [ WINDOWS v
< > < b3

Figure 2-5. Extract Program and Create Shortcut

To uninstall FLoader, navigate to the location of the *.exe file, select
the file, and press Delete.

Charging the Internal Batteries

Before using the HiPer Ga/Gb, fully charge the batteries for
maximum operating time (Figure 2-6 on page 2-9).

g The batteries are shipped from the factory without
- power. Fully charge the batteries before surveying.

With a full charge, the internal batteries should power the GPS
receiver, the Bluetooth module, and the Digital UHF radio modem
transmitting data at 1 W for at least 8 hours operating in receiver
mode; the internal batteries should power the receiver for 10 hours. If
the internal radio modem is turned off, the HiPer Ga/Gb should run at
least 12 hours with fully charged on-board batteries.

To charge the batteries:

1. Connect the power cable to the power supply unit.

2. Connect the SAE connectors on the power adapter cable and
power supply unit.
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3. Connect the power adapter cable to power port on the receiver.

4. Plug the power supply into an available outlet.

@ Use a grounded wall outlet or grounded surge
protector while charging.

5. Press the Reset key on the receiver to ensure it is in Normal mode
for charging. The receiver will not charge in Zero Power mode.

6. Leave overnight.

A nine-hour charge will charge the batteries about 90 percent. A
ten-hour charge will fully charge the receiver. The internal
batteries cannot be overcharged.

The speed of the charge depends on the Power and Charger settings
configured using PC-CDU and whether the receiver is turned off or
on. See “Power Management” on page 2-9 for more information. For
maximum battery charging speed, use one of the following
conditions:

* The receiver is turned off. Power Mode and Charger Mode are set
to Auto.

¢ The receiver is turned on. Power Mode is set to External and
Charger Mode is set to Auto.
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Figure 2-6. Insert Batteries in Charger and Connect to Outlet

The Li-Ion batteries used in the HiPer Ga/Gb should run at no less
than 80 percent capacity after 500 charging cycles. These batteries do
not need to be drained before recharging.

Power Management

Topcon’s PC-CDU software provides an interface for various
configuration, monitoring, and management functions for the
receiver.

For power management of the receiver, PC-CDU enables the power
source, enables the charging mode, and displays the current voltage
for the batteries.

1. Connect the receiver and computer. See “Connecting the Receiver
and a Computer” on page 2-14 for this procedure.

2. Once connected, click Configuration » Receiver.
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3. Select the Power Mode drop-down list to set the power source
(Figure 2-7). Current Mode displays the current power source.

* Auto — receiver automatically selects the power source

* Mix — receiver automatically detects and consumes power
from the source with the largest voltage

* Battery A — receiver consumes power from battery A
» Battery B — receiver consumes power from battery B

» External — receiver uses an external power supply

Kl Receiver Configuration E
| Genessl | MINTER | Pocifioning | Bace | Rewe | Pouts | Events | Advarced |
i (dagrons) iils ages [vollz]
T Elervaliors Mask 5 Muxke ol 175
pr— Areress Stahan reed onk] LM B
& Cumert Input- | e
i e s I ]| e Power
e > Status - |
1 ®=] | Mode:
Temperahus (Colsus dogeees] - || chege]
Cunent Mods e )
Boad lempesaiure : .
oo Yempes o phrg) [ Curent Made g
Powet outge modes Tun oo Battary &
20 |T-_| Battery B
[ ] [ TEmerr—
¥ Enable Low Powser Mode [ 2
Refiesh | |
B | Save | Set oll posameters to defaks

Figure 2-7. Select Power Mode

4. Select the Charger Mode drop-down list to set the charger mode
(Figure 2-8 on page 2-11). Current Mode displays the charging
battery: a, b, or none (off).

* Off — receiver will not charge batteries
» Charge A — receiver charges only battery A
* Charge B —receiver charges only battery B

* Auto — receiver automatically detects and charges both
batteries
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[ Receiver Configuration
| Genesal | MINTER | Posiioning | Bae | Fowns | Pruts | Events | Advarced |

; ety P managemesi
— el
T Elervaliors Mask 5 Muxke
pr— Arteres Stoha [reed onbi] L2
: Cumert Input: | ;‘:-:- | =
r Est. DE Status :
= = | Current Mode : |-
‘emperalun [Colsius degeees] - R ]
Cunmnt Mods
Bowd & e |
e Cunnern (e : |
Pow oulgrst maodes: Tun .
zicl:fon >
[ | | |
¥ Enable Low Power Mode [ 2

Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figure 2-8. Select Charger Mode

5. Select the Turn on/off Slots drop-down list to set power output on
internal slots (Figure 2-9).
* On - slot C is powered if the receiver is turned on
* Off —internal slot is not powered even if the receiver is turned

on
* Always — internal slot is powered even if the receiver is
turned off
[ Reeaiver Configuration X
| Genesal | MINTER | Posiioning | Bae | Fowns | Pruts | Events | Advarced |
i {degueec) o ourATt Vikages [vols)
Tourririal Elenvalions Mask, 5 Mocds: [t =])| | extamat:
Arizona Arveros tohus s ok b OnBowd
2 Cumerd Input e I =] || Bovera : Turn an/aff Slats
I E DO Stotus: [roa | e 20 ’m
Tompersiunn (Coksus dogenes] Comoniee: [T || Choiper:
e Cuniern e : |
Pt oulgrt made: ;lllcl;cﬂg"ﬂ .‘iiixv
[ |
¥ Enatlo Low Power Mode [ =

Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figure 2-9. Select Power Output Modes — Ports and Slots
6. View the Voltages information (Figure 2-10 on page 2-12).
» External — displays the external power supply’s voltage
* On Board — displays the voltage drawn by the receiver board
» Battery A — displays the voltage of battery A
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* Battery B — displays the voltage of battery B

* Charger — displays the charger’s output voltage during battery
charging

= - —Woltages [volts)——
[ Genesal | MINTER | Pociioning | Base | Rowns | Pouts | Events | Advarced | External : |12.1
; P
ideanes) stk Tp—— . I
Toirririd Elevealicrs Mack: 5 Mot [,,::: ‘; OnBoard: |16
firtenna Arteris Stotus s onki LUNAVESN Jor rod: | Battery & : I?.B4
; Curectinpat: [ :d';":' I ]| e o
I E DT Status - ' - (B Battery B : |7.51
3| p=| I
Temperatun (Colsius dngenes] ) N r— ]
Boad lempesaiure : Fusent e | e Charger : I?.BS
Cunet fhng): |
Powes oulgrd mades Tuan onloll Skls

= ezl =]
[ | | |

[+ Enable Low Power Mode | J

Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figure 2-10. View Voltages Information

7. Select the Enable Low Power Mode check box to put the
receiver’s processor into low power consumption mode
(Figure 2-11).

[ Reeaiver Configuration [

| Genesal | MINTER | Posiioning | Bae | Fowns | Pruts | Events | Advarced |
. Pure managermert
[l Power Vitages [vols)
Tourririal Elenvalions Mask, 5 Mexds: Extemal ;
Pi— Arberna Stotas (reed ork) Cutent Mods: O Biowd: |
; Curment Input Chorger Balioey &
- Est. DF Status : Mode: l = BatiewB: [
- 8 ,—_| atleny B |
Tompatatun [Colsus dogees| . . Chasgas: |
[= Mo ot |
Bowd lempesshure © e y T
Cusient fare): |
Pow oulgrst maodes: Tuan ool Skls
|_ 2ic): [o -
¥ Enable Low Power Maode [ I [ u |
[+ Enabla Low Power Mode [ 2l
Relresh | |
£ | _Swe | ot pwometer o defuks

Figure 2-11. Enable and Apply Power Settings
8. Click Apply.
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Powering the Receiver with an
External Battery

The receiver can use an external power source if the internal batteries
have become discharged or as a supplemental power source. External
batteries allow you to continue using the receiver in case the internal
batteries become discharged.

To check the status of the internal batteries, view the BATT LED
or check the status using available Topcon software.
* Check the BATT LEDs for battery status.
— A green light indicates greater than 85% charge.
— An orange light indicates an intermediate charge.
— A red light indicates less than 15% charge.

* Do one of the following using PC-CDU:

— Click Configuration » Receiver to view battery voltages on
the Receiver Configuration screen.

— Click Help » About to view battery voltages on the About
PC-CDU screen.

To connect the receiver to an external battery, use the receiver
power cable and the accessory battery (Figure 2-12).

1. Connect the two cables using the SAE connectors.
2. Plug the power cable into the receiver’s power port.
3. Attach the battery clip to the battery.

Figure 2-12. External Battery Connected to Receiver

P/N 7010-0816 2-13



Pre-survey Preparation

To connect the receiver to an auxiliary battery, use an SAE
extension cable and the alligator clips cable:

1. Connect the alligator clips cable to a 12-volt battery and to the
SAE-to-SAE extension cable.

2. Connect the SAE-to-SAE extension cable to the receiver power
cable.

3. Plug the receiver power cable into the receiver’s power port.

Turning On/Off the Receiver

To turn ON the receiver, press and hold the power button until the
LEDs briefly flash.

To turn OFF the receiver, press and hold the Power button for more
than one and less than four seconds (until both the STAT and the REC
LEDs are off). This delay (about 1 second) prevents the receiver from
being turned off by mistake.

Connecting the Receiver and a
Computer

Topcon’s PC-CDU software provides an interface for various
configuration, monitoring, and management functions for the
receiver.

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods and start
PC-CDU:

* a Bluetooth-enabled external device (computer/controller)
» an RS232 cable and a computer/controller

* a USB cable and a computer/controller with the TPS USB driver
installed

Once a connection between the receiver and the computer/controller
is established, you can:

* configure the receiver and its components
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* send commands to the receiver

* download files from the receiver’s memory
* upload new firmware using FLoader™

* upload an OAF

* upload configuration files to a receiver

Establishing a Wireless Connection

The HiPer Ga/Gb receiver contains Bluetooth® wireless technology
that allows file transfer and synchronization between the receiver and
any other external device that supports Bluetooth wireless
technology; for example, an FC-100 or a computer with USB-to-
Bluetooth adapter or PCMCA-to-Bluetooth adapter installed.

Changing the receiver’s Port B default settings will

@ affect the Bluetooth link. The default settings for
Port B are: 115200 bps, 8 data bits, 1 stop bit, no
parity, and no handshaking.

The receiver and external device connection procedure varies slightly
depending on the type of external device used. In general, the
connection procedure is as follows.

Refer to the Bluetooth-enabled external device
documentation for detailed connection information.

1. Turn on a Bluetooth-enabled external device and the receiver. The
default external device mode is Master; the receiver’s Bluetooth
module mode is Slave.

2. Instruct the external device (Master) to search for the receiver
(Slave).

3. Once the Master device detects the receiver, use the procedure
described in the external device’s documentation to connect it
with the receiver.
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4. Connect to the configuration software (PC-CDU, Modem-TPS,
and BTCONEF, etc.). For more information, see “Connecting to
PC-CDU” on page 3-8, “Connecting to BTCONF and Setting
Security Parameters” on page 2-18, or steps one and two in
“Configuring a Digital UHF Radio Modem ” on page 3-3 for
Modem-TPS.

If you cannot establish a connection, check that the receiver’s slot
three is enabled.

1. Connect your receiver and a computer using an RS232 cable or
USB cable and PC-CDU as seen below.
Click Configuration » Receiver » General.

3. In the Turn on/off Slots area, ensure the Slot 3 (B) check box is
enabled.

Establishing an RS232 Cable
Connection

1. Using the RS232 cable, connect the serial port of the computer
(usually COM1) to the receiver’s serial port.

2. Press the power buttons on the receiver and computer to turn
them on.

3. Connect to the configuration software (PC-CDU, Modem-TPS,
and BTCONE, etc.). For more information, see “Connecting to
PC-CDU” on page 3-8, “Connecting to BTCONF and Setting
Security Parameters” on page 2-18, or steps one and two in
“Configuring a Digital UHF Radio Modem ” on page 3-3 for
Modem-TPS.
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Establishing a USB Connection

Make sure the computer has the TPS USB driver installed and the
USB option is enabled.

or you can download it from the Topcon website

) You can find the TPS USB driver on the GPS+ CD,
—r (www.topconpositioning.com).

1. Using the USB cable, connect the USB port of the computer to
the receiver’s USB port.

2. Press the power buttons on the receiver and computer to turn
them on.

3. Connect to the configuration software (PC-CDU, Modem-TPS,
and BTCONE, etc.). For more information, see “Connecting to
PC-CDU” on page 3-8, “Connecting to BTCONF and Setting
Security Parameters” on page 2-18, or steps one and two in
“Configuring a Digital UHF Radio Modem " on page 3-3 for
Modem-TPS.

Bluetooth Module
Configuration
Use BTCONEF, Topcon’s Bluetooth module’s configuration program,
and the computer to:

* access the Bluetooth wireless technology module

* configure the Bluetooth module

* check or change the module’s configuration

To access the Bluetooth® wireless technology module, first download
and install BTCONF, then connect the computer and the receiver and
run the configuration program. See “Installing BTCONF” on page 2-
5 for details.
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Connecting to BTCONF and Setting
Security Parameters

Once BTCONEF is available (see “Installing BTCONF” on page 2-95),
follow these steps to configure the Bluetooth module:

1. Using the RS232 cable, connect the serial port of the computer
(usually COM1) to the receiver’s serial port. If needed, turn on
the receiver and computer.

2. Run the Bluetooth module configuration program (Figure 2-13).
3. For BTCONF version and copyright information, click About.

BTCONF (=3

w|  Identification l Parameters] Serial Interface]

Bluetoath Information:
About
Connect

L |
[Shssise]

Exit

Disconnected

Figure 2-13. Bluetooth Module Configuration Main Screen

4. From the drop-down list in the upper left corner, select the
computer serial port (usually COM1) used for communication
(Figure 2-14).
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5. Click Connect to connect the computer and Bluetooth module.

BTCONE

COM1 > || Identification l Parameters | Serial Interface]

Bluetoath Information:
I Ok i I About

[Bhsansss|

Exit |

Disconnected

Figure 2-14. Select Communication Port and Click Connect

Once the receiver and computer connect through BTCONF, the
Identification tab (Figure 2-15) displays the following
information:

¢ Bluetooth name — the name of the Bluetooth module.

* Bluetooth address — the unique electronic address for the
module.

¢ Firmware version — the current firmware version of the
Bluetooth module.

BTCONE

Identification | Parameters | Serial Interfacs ]

Bluetoath Information:

Abaut Bluetoath name: GR3 Rowver

Bluetooth address: 0028 BEED 0074 0003
Firmnware baze: RFCOMMI.1w16.4.4
Firmweare version: ¥1.3 pl

Disconnect

Lk

Exit

COM1, 115200

Figure 2-15. BTCONF Identification Tab

The COM port and baud rate display in the lower left corner.

6. Click the Parameters tab (Figure 7). The Parameters tab sets
identifying and security information for your Bluetooth module.
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The security section allows you to set data security and
unauthorized access parameters for the Bluetooth module.

7. Enter up to 14 characters to set a unique name for the Bluetooth
module (Figure 7).

8. To set security parameters (Figure 2-16 on page 2-20), enter and
enable the following, then click Apply:

* Bluetooth PIN — enter up to 16 characters to specify a
personal identification number for the Bluetooth module.

* Encryption — enable to have the Bluetooth module encrypt
wirelessly sent data. To read encrypted data, the user must
have the same PIN used in the device that sent the data.

* Authentication — enable to require a PIN before two
Bluetooth enabled devices (such as, the receiver and a
computer) can establish a communication link. The two
devices must use the same PIN.

If you do not need security settings, leave these
parameters disabled.

BTCONF (=3

Identification Parameters l Serial Interface]

About Bluetaath M ame: |GF|3 Fover
Security

Blustaoth PIN: [ 1234567
k Encryption: v
Disconnect
Authentication: v

Exit |

COM1, 115200

Figure 2-16. BTCONF Security Parameters

9. Click the Serial Interface tab (Figure 2-17). Enable Echo to
display Bluetooth module replies and corresponding commands
on the computer terminal. Click Apply.
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10. Click Disconnect and then Exit to quit BTCONF.

BTCONF (=3

Identification] Parameters l
About Echa: [~

Apply

Disconnect

e

Exit

COME, 115200

Figure 2-17. BTCONF Serial Interface Tab

Collecting Alimanacs and
Ephemerides

Each satellite broadcasts a navigation message that includes the
ephemeris parameters of the satellite, the almanac, and various other
information. The ephemeris parameters describe the orbital motion of
the satellite and are used to predict its location/trajectory. The
almanac gives the approximate orbit (course) for the transmitting
satellite and all other satellites in the same system.

* GPS and GLONASS satellites broadcast ephemeris data
cyclically, with a period of 30 seconds.

» GPS satellites broadcast almanac data cyclically with a period of
12.5 minutes; GLONASS satellites broadcast almanac data
cyclically with a period of 2.5 minutes.

If the receiver has an almanac, you can considerably reduce the time
needed to search for and lock onto satellite signals.

The receiver regularly updates the almanac and ephemerides and
stores the most recent versions in its Non-Volatile Random Access
Memory (NVRAM).

To collect Alamac and Ephemerides data:
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1. Set up the receiver (connect the external antenna, if needed) in a
location with a clear view of the sky.

Turn on the receiver.

Wait for about 15 minutes while the receiver collects complete
almanac and ephemeris data from the satellites.

lock onto satellites, clear the NVRAM. See

@ If 15 minutes have passed and the receiver does not
“Clearing the NVRAM” on page 5-13 for details.

You will need to collect or update the almanac and ephemerides under
the following circumstances:

* If the receiver has been off for a long time.

If the last known receiver position, stored in the NVRAM, is
different from the present position by several hundred kilometers.

After loading a new OAF.

After loading new firmware.
* After clearing the NVRAM.

* Before surveying.
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Chapter 3

HiPer Ga/Gh
Configuration

Both Base and Rover receivers must be configured according to the
survey method needed.

* In applications where real-time positioning results are required,
the Base receiver provides the correction information needed to
properly measure the location of the Rover receiver.

A Base station is normally set up over a known point and collects
GPS/GLONASS data from satellites. As the receiver picks up
satellite data, it measures the carrier and code phases to
accurately compute and verify its location. The receiver transmits
this information via radio link to the Rover receiver.

* The Rover receiver applies correction information from the Base
station to its current location to accurately calculate one or more
points.

Rovers are mobile GPS receivers on a survey pole or bipod that
compares the information from the Base station to the data it logs
from satellites and applies correction algorithms to accurately
calculate a new point.

* In applications intended for post-processing, the receivers
typically log code phase and/or carrier phase measurements
separately from common satellites and during the same time
interval. This data is then processed using post-processing
software (for example, Topcon Tools).
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When configuring receivers for RTK surveying, use the following
checklist to ensure the receivers are properly set up:

O Perform pre-survey functions as described in Chapter 2.

[J Configure one receiver as an RTK Base station and the other

receiver as an RTK Rover. See “Configuring the Receiver” on
page 3-7.

O Configure the communication data link for transmitting and

receiving corrections. See “Configuring the Radio Modem” on
page 3-3.

O set up the Base receiver over a known point to begin collecting
static observation data and transmitting corrections. Set up the
Rover receiver to begin collecting RTK data. See “Receiver
Setup” on page 4-1 for more information.

When configuring receivers for post-processing surveying, use
the following checklist to ensure the receivers are properly set up:

O Perform pre-survey functions as described in Chapter 2.

[J Configure one receiver as a Base station and the other receiver as
a Rover. See “Configuring the Receiver” on page 3-7.

0 set up the Base receiver over a known point to begin collecting
static observation data. Set up the Rover receiver to begin
collecting static or kinematic observation data. See “Receiver
Setup” on page 4-1 for more information.
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Configuring the Radio Modem

Modem-TPS is Topcon’s radio modem configuration utility for
modems embedded in Topcon receivers. Modem-TPS (version 2.2p2
or newer) provides the following functions:

» Connecting a computer to an integrated radio modem via a serial
port or Bluetooth wireless technology.

* Displaying information about the radio modem installed in the
receiver.

* Programming the radio modem’s settings.

always disconnect from Modem-TPS before exiting

% When finished configuring the radio modem,
to prevent conflicts with serial port management.

Topcon’s configuration and surveying software, TopSURYV or
Pocket-3D, also have the ability to configure Topcon receivers. Refer
to the TopSURYV or Pocket-3D manuals for details.

Configuring a Digital UHF
Radio Modem

% To comply with RF exposure requirements,

maintain at least 25cm between the user and the
radio modem.

The integrated radio modem provides TX/RX UHF communications
between a Base Station and a Rover. To configure the UHF radio
modem, have the following ready:

* PC running Windows 98 or newer
* Modem-TPS 2.2p2 or newer
* A Serial cable or Bluetooth connectivity with PC

1. Connect the computer and receiver using an RS-232 cable or
Bluetooth wireless technology. Turn on the receiver.
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2. Open Modem-TPS, and select the COM Port the receiver is
connected to (Figure 3-1 on page 3-4). Click Connect.

Ele ook tep

Fort's sething

com d
Cancel

Disconnoctod

Figure 3-1. Connect to Modem-TPS

3. On the Radio Link tab, set the following parameters (Table 3-1)
for the base station’s and rover’s radio modem, and click Apply
(Figure 3-2 on page 3-6).

Table 3-1. Receiver Parameters for the Radio Link Tab

Parameter Base Receiver Rover Receiver

Protocol ¢ Select PDL w/EOT to work with Pacific Crest
compatible modems

» Select TRMB to work with Trimble UHF compatible
modems

* Select Simplex to work with TPS Digital UHF
compatible modems

Note: The same protocol must be used for both the base
and rover to communicate properly.

Modulation » If PDL w/EOT or TRMB protocol is selected, use
GMSK (recommended for most applications).

 If Simplex protocol is selected, use either DBPSK or
DQPSK.

Note: The same modulation must be used for both the

base and rover to communicate properly.

Mode Select Transmitter Select Receiver
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Table 3-1. Receiver Parameters for the Radio Link Tab

Parameter

Base Receiver Rover Receiver

Channel

Select the desired frequency from the channel list.

Note: The same channel must be used for both the base
and rover to communicate properly.

Forward Error
Correction (FEC)

Enable to maximize data communication. The rover radio
modem has the capability to check and correct
transmission errors (if any) in an incoming data stream.

Scrambling

¢ For PDL w/EOT and TRMB protocols, enable
scrambling to provide more robust data
communication over high interference areas.

* Scrambling is not supported when Simplex protocol is
selected.

Output power

Select the transmission n/a
power for the radio
modem (from 10 mW
to 1W).

Link rate

Select 9600 as the link rate, which is the default link rate
for GMSK (recommended for most applications) and
DBPSK. The link rate is the rate at which data is
transmitted over the RF link.

For maximum efficiency, the data packet size transferred
to the radio modem in a given time should be equal to or
less than the link rate. See Table 3-2 on page 3-6 to
determine the link rate.
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= b
Fle Took Help
Radio Link | GEMICOMA | Serial intertace | Idertification |
Apply
Protocat | POLwECT ¥ Che| A58 S50 |
= b
Modulation: [ Gisk z]  Ferward Emor Comaction: [P Tokt b0
Serambling. &
Maod: Transmite wd
B — Link 10: i Radio Link | GEMICOMA | Serial intertace | Idertification |
Metwerk tras Repeater.
Protocat | POLwECT ¥ Che| A58 S50 |
Link Rate: 2600 0| P
Modulations [ Gwsk x|  Ferward Emor Comaction
w3 ot |
Output povwer TW Dealer Conig Serambling: ¥
i Mad Recerur
Exit e weenr Lk ID |1_
COMI, 115200 0002 kbbb o
Link Rate: 2600 0|

COutput power: 1w =] Deealer Corfig |

Exit

COM1, 115200 00023

Figure 3-2. Apply Radio Link and Baud Rate Parameters

Table 3-2. Link Rate vs. Modulation Type

For this Link Rate Use this Modulation Type

4800 baud GMSK
9600 baud (default; recommended) GMSK (default; recommended)

4. On the Serial Interface tab, select the following baud rate
parameters and click Apply (Figure 3-3).
* Baud Rate — select a baud rate for the modem’s serial port.
The same rate must be used for the receiver and the modem.
Recommended baud rate is 38400.

* RTS/CTS - controls the flow of data between the receiver and
modem. “On” enables handshaking/hardware flow control.

hardware handshaking to prevent the radio link

% If the serial baud rate exceeds the link rate, enable
from overflowing, resulting in data loss.

5. When finished, click File » Disconnect.
6. Click File » Exit to close Modem-TPS.

3-6 HiPer Ga/Gb Operator’s Manual



Configuring the Receiver

7. Launch PC-CDU and set up the receiver to run as an RTK Base

station.
i
Fle Took Help
Radia Link | GEM/COMA  Serial Intedtace |I||H|Inﬁcamnn
Blaud Rt £
RTSICTS: anN =
Exit
COM1, 115200 0:15:25

Figure 3-3. Apply Baud Rate Parameters

Configuring the Receiver

The HiPer Ga/Gb can be configured in several ways for collecting
data for RTK or post-processing.

¢ A static Base station collects measurement information and saves
this data to its internal memory.

¢ An RTK Base station collects measurement information,
determines differential corrections, and transmits them to the
RTK Rover(s).

¢ A static Rover collects observation data from the same satellites
during the same time interval as the static Base station.

* An RTK Rover collects measurement information and accepts
corrections from the RTK Base station to compute its relative
position.

* A Rover acting as a repeater to re-transmit RTK Base station
measurements to other rover receivers, extending the range of a
GPS system.
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Connecting to PC-CDU

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods, and start
PC-CDU:

* Computer running Windows® 98 or newer

* Modem-TPS ver. 2.2p2 or newer installed on the computer

« An RS-232 cable or Bluetooth® wireless capabilities

PC-CDU is Personal Computer-Control Display Unit software used
to manage the various functions of your receiver. The full range of
PC-CDU configuration and function is outside the scope of this
manual. For more information on any of the procedures in this section
or on PC-CDU, refer to the PC-CDU User’s Manual available on the
TPS website at www.topconpositioning.com.

PC-CDU configures the various parts of the receiver, saving the
settings in the receiver’s memory. These settings are reflected when
you use the MINTER. The full range of PC-CDU configuration and
function is outside the scope of this manual.

Once you have established a connection between the receiver and the
computer, you can:

* configure the receiver and its components

» send commands to the receiver

* download files from the receiver’s memory

* load a new OAF and other configuration files to a receiver

The following Base and Rover configurations are recommended for
the most common applications; however, you can select configuration
parameters as needed for your particular jobsite.

'ﬂT Do not make other changes without consulting the
[WARNING]) PC-CDU Reference Manual.

1. Connect the receiver and computer as described in “Connecting
the Receiver and a Computer” on page 2-14.
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2. Start PC-CDU on your computer. The PC-CDU main screen

displays (Figure 3-4).

I (=l eS|

Edrc-cou
Eile cConfiguration Tools Plots Help
GPS Satellites Geo |z | Terget|

# [ EL| azfcalppel T 55 Lat
Lo
Alt
el
RMS Pos:
RAMS Vel
FDOP:
Receiver time:
Receiver date:
Clock offset:
Osc. offset :
Tracking time:

GLONASS Satellites

snlFn| EL[ sz[cal P pPe] 1] s8]

Disconhected

Figure 3-4. PC-CDU Main Screen

Notice that the lower-left hand corner shows the receiver status as

“Disconnected.”
3. Click File » Connect.

On the Connection Parameters dialog box, select the following
parameters (Table 3-3) and click Connect (Figure 3-5).

Table 3-3. Connection Parameters

between the receiver and the
computer (usually 115200).

Parameter RS232 or Bluetooth usB
Connection Select Direct.
Mode
Port Select the port connecting the | Select USB
computer and receiver
(typically COM1, COM2 for
RS232 and COM3, COM4
for Bluetooth)
Baud Rate Select the communication rate | n/a

Rec ID n/a

Select the receiver’s
identification number.
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RS232 or Bluetooth

x|

|'Ennnat:tinn modes

(= Direct = Intemet Client

" Intemet Server |

Paort setting:
Port: [COM1
[~ RTS/CTS handshaking

rProgram setting:
[T Passivemode [~ Manual mode anly

[~ Restore the receiver's original baud rate on Disconnect

Intemet setting:

Hostname: Iln:alhnst

TCP port: Iﬁ

Fassysard; I

j Baud rate: |715EUU j [” Infrared po [ Connection Parameters

usB

Connection mode
(f’ Direct
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~Port setting:
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=

Rec ID: IEPAZK5E41KW ;I = Infrared port

—Progrann setting:
I~ Passive mode

[T Manual modeonly Timeouk [ms]: |S00 -

[~ Display data arn senver
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Connect I

Cancel |
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Internet [ Client - Server ] setting:

Hast rame: floc alhost TR port: [6000
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™| Display dataonserver ™| Logjserver events [~ DHS lockup
Connect I Cancel I

Figure 3-5. Connection Parameters

Once a PC-CDU connection with the receiver has been
established, the current communications settings—such as, port
name, baud rate (if applicable), and flow control (if applicable)—
display in the lower-left corner of the main window of PC-CDU.
A timer begins to count up in the lower-right corner as well
(Figure 3-6).

File Configuration Taools Plots  Help
GFPS 5atellites [0)
g [ EL] az[calpifref 7e] ss]

=lolx|

Geo |wvz | Taget| GLONASS Satellites (0]
Lat Sn[Fnl L] az[cal e[ pa] 7o ss]
o

I
Alt:
el
RM3 Pas:
RS el
PDOP:

FRecaiver time: 08:06:07
Receiver date: 24.03.2002
Clack affset:

Osc. offset

Tracking time: 00;00:00

oMz, 115200 I 000012

Figure 3-6. PC-CDU Connection Established
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5. Select Configuration » Receiver.

change; otherwise, the receiver will not register the

% Click Apply after making any configuration
change.

6. Click Set all parameters to defaults (Figure 3-7).

=
Gonesod | MINTER | Pesatunng | Bsve | Hove | Porte | Evens | Ardvarse |
Pawrs mannaemert
Elerwialior ik [chegrmnz] P Vokages fvelst
Torraal £ lervalion Mask. 5 Mode: m Extainal: ,—
Aninnna Anberea Stanss read ok Cusiert Mo+ [ 0n Boaed -
1 Intemal Cumert Input o
" Extmnal el Baitery 4
i Ext. OC Status - [0 Mads: b =
Eamey 8. |75
Temperatue (Cebis dogeess} s 2
f Cunert Mode Chesgie:
Foaver nulpul moder Turm ondolt Siots
itz [ L R
7 Skt d
Set all parameterto defaults Shay - On =] | || skt
7 Engtle Low Powar Mode
Heliesh Aoy

OF. I Lt Save | Get ol pas defauks

Figure 3-7. Set All Parameters to Defaults

7. Click the MINTER tab, enter the following settings
(Table 3-4), and then click Apply (Figure 3-8).

Table 3-4. Receiver Parameters for the MINTER Tab

Parameter Base Receiver Rover Receiver
Recording Enter 15 seconds.
interval
Elevation Enter 15 degrees.
mask angle
File name Enter a unique ID, such as the last 3 digits of receiver’s serial
prefix number.

FN key mode || (starts/stops data recording using the FN key)

For Static data recording, For RTK data recording,
select LED blink mode switch. | select Occupation mode
switch.
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Table 3-4. Receiver Parameters for the MINTER Tab (Continued)

Parameter Base Receiver Rover Receiver
Initial data n/a Select Kinematic.
collection (This setting is for trajectory
dynamic surveys.)
mode

FM keymode—————
& LED blirk mode switch
Genessl MINTER | Pooatunrg | Bave | Hove: | Puts | Events | Ardvarse | /

Fecondng inenval | 1.00 lseconds] FH ky mode: Statlc
Elevalion mazh fra Log e - ,5_ ldegrest] (% LED birk mode swich Occupation mode swich
Filss rusenm prsloe Il Irital data collaction dynamic mode

~ Kine
"Fihacyys opgerad 1 o b | RTK Rover
Fiers Comation e Data recunding auto-slat
= Loghis  AFRM & on  On bl

Puomate; Fike Flotalion Mods WFRM) pasaseless
i ' Oceupation mode switch

Recording interval : |1 il [seconds)  mod
Elevation mask. fior Log file : |15 [degrees) % Kinematic
File name prefix : log
Reliesh Aafy ||
OF | _ Gt | Save | Senolpacsmetecs o datouks |

Figure 3-8. Configure Receiver’s MINTER for Data Recording

8. Click the Positioning tab, and set the Elevation mask to 15
(Figure 3-9), then click Apply.

=
Genessl | MINTER [Fosonng | tave | Hove: | Puts | Events | Ardvarsed|
& Standsionn % Standaione [ S s
€ DGPS [Code Dilleveriia] il I GRS [ GLOn I© Grs s
 BTK Fioat P —
© RIF Famd F GPS | GLonass | waas |
= — k| s panlock e ] s | panl ek e
2 1 & N = P R .
Ehey e s
[‘:’on“nlsal 5 e 2FF WFF BFF XFF
OF mark; |00 I GLONE IFF NFF BFF HFF
7 ANEneied MecnmemarnsUieds || AF K RFIF AR FL B8R
Tr\n;‘ = A1 SFF NFF AR F AR F
Elevation mask s ~ EF R B B2 e SR e B
[degres): [15 EZ PR BRF AFF AFF
LN I - = ) o i < i )
T | - Ao lock | Nonetoloct] | ltouse | Moo to e
Do Paramaters I
| Reliush agy) |

OF. I Lt Save Gnlalnnlmeulodefml

Figure 3-9. Configure Receiver Positioning — Elevation Mask

9. For the Base receiver, click the Base tab and set the following
parameters (Figure 3-10 on page 3-13), then click Apply.
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Configuring the Receiver

e GPS/GLO at one time — enable

* Antenna position — enter Lat, Lon, and Alt values using one
of the following methods:

— If known, type in the values.

— Enable Averaged, and enter the Averaged Span in
seconds, and then click Apply. Click Tools » Reset
receiver, and wait until the specified interval (span)
completes. Examine the Base coordinates on the Base
tab; they should correspond to the coordinates obtained
from the average. Click Refresh if the coordinates are
Ze10s.

— Click Get from receiver.

The reference geodetic coordinates specified on this
tab relate to the antenna L1 phase center.

&+ GPS/GLO at one time =

Generdl | MINTER | Porifioning [ 8522 || Rover | Ponts | Events | Advanced|

Elaue Stalion: Cucedinates | Al erma Fhass Cerier | ATCM Setngs P
FRESA Rl i Sisont0: [0 7 CALY ™ P PA2
e - e [ [ StemUsed
GPS/GLO | el o e F GPS I+ GLONASS
Hesth:[Geod = ;
Pelerente Geodstic Comdnaer ™ Prouorange sxothig
La[o0 o0 “[ooomon “[u =][wes =] |[J [CMA Setings ————
Leee[000 ‘00 0000000 *[c = Staion 10 [0 & CaLl P PAZ
AR [-0000 Dianm Pauamainis Mation: [Unkrown,  v] GLOMASS message:[F 3]
Anianna Phase Center olfsats. mebars Shoa 10 | 0G0 : [
st 0 Jome eghfomos |||
o - Coriigursiion of Necsivst Ports
GPS/GLO | e from receivei| :
Han 5 Relresh . |
Reference Geodetic Coordinate: |

Lat [0 *[o0” '[on.oooon " [w =] [wes =]
Lonfo00 *[00" ' [on.00000 " [€ =]
AIt:I+U.DDDU M Diatum Farameters |

Figure 3-10. Base Configuration

10. For the Rover receiver, click the Rover tab and set the following
parameters, then click Apply (Figure 3-11 on page 3-14).

* Positioning Mode — For post-processed surveys, select
Standalone; for RTK surveys, select RTK float or RTK fixed.
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* RTK Parameters, RTK mode — select either Extrapolation for
RTK float (kinematic) or Delay for RTK fixed (static).

— Extrapolation is for low-latency, high frequency output
(= 5 Hz) RTK applications. The Rover will extrapolate
the Base station’s carrier phase measurement corrections
when computing the Rover's current RTK position.

This setting (extrapolation) is recommended.

— Delay is for 1 Hz high precision RTK applications. The
Rover RTK engine computes either a delayed RTK
position (for the epoch to which the newly received
RTCM/CMR message corresponds) or the current stand-
alone position (while waiting for new RTCM/CMR
messages coming from the base).

* RTK Parameters, Dynamics — select Static or Kinematic.

* RTK Parameters, Ambiguity fixing level — (not applicable to
RTK Float) select either Low, Medium, or High for indicator
states of 95%, 99.5%, or 99.9%, respectively. The RTK
engine uses the ambiguity fix indicator when making
decisions whether or not to fix ambiguities. The higher the
specified confidence level, the longer the integer ambiguity
search time.

R Positioning Mode
Genese | MINTER | Fostong | Bas | Hover | Pots | sabvercd | Standalone ¢ RTK Float
Poaiinring Mode Enabin Sokisons— | ™ OGS [Code Differential]  RTE Fixed
© Standakne  ATK Float 7 Standons
€ DGPS [Code Dilleeriia) & RTK Foesd F7 DG
TR RTK Fasisim
15 5as RITE made Dymamics Ambigity i level
" Evtrapalstions | Static 7 Low

ik

p B ks 3
|

RTKP.

RTK mode—— [ Diynamic: Ambiguity fizing level
J— T | ’V(" Extrapolation ’V(" Static ’V(‘ Law

. . & Medium
&+ Kinematic " High

* Delay

OF. I Lt Save Gualnﬂunumhdefml

Figure 3-11. Rover Configuration

Continue with step 11 for RTK surveys or step 12 on page 3-16.
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11. For RTK surveys, click the Ports tab and set the following port
parameters for the serial port (Table 3-5), then click Apply
(Figure 3-12 on page 3-16).

For post-processed surveys, keep the default values
for these parameters.

Table 3-5. Receiver Parameters for the Ports Tab

Parameter Base Receiver Rover Receiver
Input n/a (Leave the default.) Select the same differential
correction format selected for
the Base.
Output Select the type and format of Select “None.”

differential corrections.

Period (sec) Enter the interval at which the | n/a (Leave the default.)
receiver transmits differential
corrections.

Baud rate Select a baud rate to use for transmitting differential messages
from the receiver board to the modem module

The baud rate must match the modem’s serial port speed.

RTS/CTS Select to enable handshaking.
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£l Recuives Conligu ation

Genesl | MINTER | Positoning| Bate | Rower Pute | Evenis | Advanced

Sosl | Paratel| Mo | USE | Ethenet | TCP |
o T - 2 Haudiala: |115701 =
Ot [ 7] Pesdi [ r
g et [Lenmand = Bad e [115200 =
Oupis: [Hane =] Peiedia: | I RTSATS
) Irgut; | Command - Basdrale: [ 0400 =
Seial C
Duget; [CMA - Period [1]: || ]  RISZIS
SeislD  Igud: | Command = Honsdioln - |115200 = \
[ Intied pggar: [Hone =] et [ ™ RTS/TS
Base e | i)
. Iput : IEommand 'l Baud rate : |334DD 'l
Serial C
Output: |CMR A Period (2] : |1.UU W RTS/CTS

Réver

. Input: |CMR - Baud rate : |334DD 'l
Serial C
Output : INone 'l Period [sec]:l [~ RTS/CTS

Figure 3-12. Base and Rover Configuration for RTK Surveys — Ports

12. Click the Advanced tab, and then the Multipath tab. Set the
following parameters, and click Apply (Figure 3-13 on
page 3-16).

* Code multipath reduction — enable

e Carrier multipath reduction — enable

Genessl | MINTER | Peastinrg | Basm | Fove | Pute | Events Advorced |

At lnkrsemeracr. Wulipath Reduchion | Loy Momagernes | Estrana Faesparrey | Fows Datia Morsagraset | Ot |

¥ Code multipath reduction

esteen] |

OF. I Lt Save Gualnﬂunumhdefml

Figure 3-13. Configure Mulitpath Parameters

13. Click OK to save the settings and close the dialog box.
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Once the receiver is configured, the configuration remains until
you change it using PC-CDU/TopSURV/Pocket-3D or clearing
the NVRAM.
For more details on the settings available for configuring the Base
and Rover receivers, refer to the PC-CDU Reference Manual.

14. Continue with other configuration activities or click File »
Disconnect, and then File » Exit to quit PC-CDU. Disconnecting
before exiting ensures proper port management.

exiting to eliminate possible conflicts with the

@ Disconnect the receiver from PC-CDU before
management of the computer’s serial ports.

MINTER Configuration

The Minimum INTERface (MINTER) consists of two keys (Power
and FN) that control the receiver’s operation, four LEDs (STAT, REC,
BATT, and RX) that display the receiver’s operational status, and two
LEDs that display the battery status (Figure 3-14).

Power Key Battery LED
Status LED

@ Serlal Pcnvrts f@)\

L Record LED
FN Key Modem Status

LED

Figure 3-14. MINTER

The MINTER performs the following functions. For more
information on using the MINTER, see “MINTER Operation” on
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page 4-7.

Turns the receiver on or off; puts it in either Sleep or Zero Power
mode.

Turns data recording on or off (FN key).
Changes the receiver’s information mode.

Shows the number of GPS (green) and GLONASS (orange)
satellites being tracked (STAT LED).

Shows the data recording status (REC LED).

Shows each time data is recorded to internal memory (REC
LED).

Shows the status of post-processing mode (static or dynamic)
when performing a Post-Processing Kinematic survey with the
help of FN key (REC LED).

Shows the status (high charge, intermediate charge, or low
charge) of the battery (BATT LED).

Shows the power status for the receiver (BATT LED).

Shows the status of the modem and if it receives signals (TX RX
LED).

Shows Bluetooth activity (BT LED).

Use PC-CDU to configure MINTER settings. The procedure below
describes the most common settings; refer to the PC-CDU Reference
Manual for other possible MINTER configurations.

To configure the MINTER:

1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

On the PC-CDU Main window, click File » Connect.

On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 3-15).

See “Connecting the Receiver and a Computer” on page 2-14 for
details on setting other parameters.
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Click Connect.

MINTER Configuration

[ Connection Parameters E|

Connection maod

" Intemet Client " Intemet Server

Pt setling

Port: [com1 =] Baudsate: [115200
r [¥ RTS/CTS handshaking

=] I Infrared port

y 4

Program seting
[ Passivemods [~

nusl mode only  Timeout [msk |500 B

[v¥ RTS/CTS handshaking

iginal baud rate on Disconnect

TR port: (2000

Passord: |

I” Display data o server W Log server events

I~ BHE loskup

Cancel

Figure 3-15. Connection Parameters — MINTER Settings

5. Click Configuration » Receiver, and then the MINTER tab. Set
the following parameters, and click Apply (Figure 3-16). See the
following pages for descriptions of these parameters.

* Recording interval on page 3-20

e Elevation mask for log file on page 3-20

* File name prefix on page 3-20

* Always append to the file on page 3-20

* Files Creation mode on page 3-21
* Automatic File Rotation Mode (AFRM) on page 3-21
* FN key mode on page 3-22

* [nitial data collection dynamic mode on page 3-22

* Data recording auto-start on page 3-23
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[ Receiver Configuration x|

General MINTER | Posiioning| Base | Rover | Ports | Events | Advanced |

Recarding interval 100 (secands) FN key mode:
Elevalion sk for Logfie:  [5 | (dearees] [rr LED bik mode switsh ¢ Occupation mode svitch

File name prefis log il date cllsction i o
Always append to the file [F Siallc € Kinematic

Files Creation mode Data recarding auto-star
((-‘ Loa file £ AFRM | [rr off < On ' Always

Automatic File Flatation Made (AFRM] parameters———

Pariod(s=c) - [3600 Fies (ratal ) [0
Phase (sec): [0 Fies [remain] [0

I | Auternaticall remave old files

|

Exit Save | et all parameters to defauits |
Figure 3-16. Receiver Configuration — MINTER Tab

Recording Interval parameter This parameter specifies the logging
rate of the log file when the MINTER FN key (pressed for 1-5
seconds) activates data logging. This setting is used for both logging a
single log file and logging receiver data in AFRM mode. Values are
1-86400 seconds. The default value is one second.

Elevation Mask for Log File parameter This parameter specifies the
minimum elevation angle for the satellites whose data is put in the
receiver files logged when pressing the FN key. The default value is
five degrees.

File Name Prefix parameter This parameter specifies the prefix
added to the names of receiver files created when pressing the FN
key. The prefix can be up to 20 characters long. The default value for
the Name Prefix is “log.”

Log file names have the following structure:
<prefix><month><day><sequential alphabet letter>

The file name depends on both the file creation time (month and day)
and additional letter suffixes to avoid confusion between files created

on the same day.

Always Append to the File parameter If you want new receiver
data to be appended to an existing log file, enter the desired file name
in this parameter. The setting can be up to 20 characters long.
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Files Creation Mode parameter This parameter has the following
operation modes:

* Log file — If the log file radio key has been selected, pressing the
FN key closes the current log file. If data logging is off, pressing
the FN key opens a new log file.

* AFRM - If AFRM radio key has been selected, pressing the FN
key enables this mode. If AFRM has been enabled, pressing the
FN key disables this mode.

Automatic File Rotation Mode (AFRM) parameters TPS receivers
are capable of automatically rotating log files. During a “file rotation”
event, the receiver closes the current file and opens a new one
according to a user-defined schedule. The Period and Phase
parameters specify this schedule. File rotation launches the moment
the receiver time module Period is equal to Phase. More precisely, a
new log file opens immediately before the scheduled epoch causing
data tagged with this epoch to be recorded to the new log file.

When opening a new log file, the receiver enables the default set of
messages output with the default output period. Both the default set of
messages and the default output period are programmable.

* Period — specifies the time duration of each log file created in
AFRM mode. Values are 60 to 86400 seconds; default value is
3600 seconds.

* Phase — specifies the “phase” (constant time shift) of creating
multiple log files in AFRM mode. Values are 0 to 86400 seconds;
default value is zero seconds.

* Files (total) — a counter that specifies how many multiple log files
must be created in AFRM until this mode automatically turns off.
This counter decrements on every file rotation until its value
becomes zero, then file rotation automatically stops. The counter
initializes with AFRM.

Note that a log file opens immediately after turning AFRM on.
This startup file is not considered a file rotation event; the AFRM
counter will not decrement.
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Values are 0 to [231—1]; default value is O (zero). Zero means that
an unlimited number of log files are created.

@ The receiver’s memory holds up to 512 files.

* Files (remain) — specifies the number of files left for the receiver
to create in AFRM. Values are 0 to [23 1—1]; default value is zero.

* Automatically remove old files — when no free memory is
available to log data, automatically removes the earliest log file. If
this parameter is enabled, then the receiver erases the file with the
earliest file creation time/date. AFRM must be enabled to use this
FIFO (First-In, First-Out) feature. The default value is off
(disabled).

FN Key Mode parameter Use these two radio buttons to program
how the receiver reacts when pressing the FN key.

* LED blink mode switch — pressing the FN key toggles between
the MINTER’s normal/extended information modes and start/
stop data recording of Static survey.

— Pressing the FN key for less than 1 second changes the
information mode (Normal or Extended Information Modes).

— Pressing the FN key for 1 to 5 seconds starts or stops data
recording (Static post-processing mode).

* Occupation mode switch — pressing the FN key (less than one
second) will insert a message into the corresponding log file,
indicating that the survey type changed from static to kinematic,
or vice versa. If the REC LED blinks green, the current mode is
dynamic, if it blinks orange, the current mode is static. For more
details, see Table 1-2 on page 1-12 and refer to the PC-CDU
Reference Manual.

Initial Data Collection Dynamic Mode parameter These radio
buttons specify the starting occupation type descriptor inserted at the
beginning of receiver files logged. Select Static or Kinematic to
specify that the corresponding log file starts with a static (STOP) or
kinematic (GO, Trajectory) occupation, respectively.
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Data Recording Auto-start parameter These radio buttons allow
you to program your receiver’s behavior in the event of a power

failure.

Table 3-6 describes the different scenarios available and the results
after power is restored to the receiver. “Specified file” refers to the file
name entered in the Always append to file field.

Table 3-6. Data Recording Parameter Behavior

Before Enabled Radio Button Results

Power

Failure Off On Always
Receiver data | Data logging Receiver resumes | Receiver resumes

logged to file | does not resume datalogging tothe | data logging to the
specified. when power is same file when same file when power
restored. power is restored. | is restored.
Receiver data | Data logging A new log file A new log file opens
logged to does not resume opens when power | when power is
default file. when power is is restored and restored and data logs
restored. data logs to this to this file.
file.
Filespecified; | File willnotopen | File will notopen | A log file with this
receiver data with this name. with this name. name opens and data
logging not Data logging Data logging does | logging starts after
started. does not start not start when power is restored.
when power is power is restored.
restored.
No file Datalogging will | Data logging will | A log file with a
specified; not start when not start when default name opens
receiver data power is restored. | power is restored. | and data logging
logging off. starts after power is

restored.

Also, if Always is enabled, the receiver automatically logs data (to a
newly created or an existing file) in the following three cases:

* After turning on the receiver using the Power button.

» After resetting the receiver (using PC-CDU).
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* After taking the receiver out of Sleep Mode.

Ed Receiver Cor
General  MINTER: | Posiioning | Base | Rover | Parts | Events | Advanced |

Recording interval 100 | (seconds) ’rm key mode

Elevation mask for Log fils : 5 [dearees]
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Always append ta the fis -

1% Gtafic £ Kinematic

Files Creation mad Data recording autorstar
[F Loafie  AFRM ’7(-‘ O C On  Blways

Automatic Fils Ratation Mods [AFRM) parameters———

Pesind [see] [ 3600 Files {total]: [0

Phase [sec]; [0 Files (remein] |0

™| Automaticallyremove ofd fles

Refiesh | dpfu |

[ok | s Save | Sel all parameters to defaults |

Figure 3-17. MINTER Tab
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Chapter 4

HiPer Ga/Gb Receiver
Setup and Survey

After receiver survey configuration, set up each receiver, measure its
height, and begin surveying. The MINTER provides quick access for:
logging data, changing receiver modes, and viewing general data
logging and satellite information during a survey.

Receiver Setup

A typical GPS survey system consists of a Base station set up over a
known point and a Rover receiver set up to be a mobile data collector.
After setting up the Base and Rover receivers, the antenna height
must be measured.

Before collecting data, make sure the Base and Rover receivers
contain a current almanac and current ephemeris data (see “Collecting
Almanacs and Ephemerides” on page 2-21).

Step 1: Setting Up the Receivers

The Base station must be set up, logging data, and transmitting data
before setting up the Rover receiver.

[J Set up the Base station and its components.

See “To set up the Base receiver” on page 4-2 for details.

O set up the Rover receiver.

See “To set up the Rover receiver” on page 4-3 for details.
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To set up the Base receiver (Figure 4-1):

1.

Install a tripod over a known control point, and secure the
universal tribrach to the tripod.

Place the tribrach adapter (either universal or precision) on the
tribrach, and tighten the screws.

Insert the L-plug (horizontal spacer) into the tribrach adapter.

Attach the HiPer Ga/Gb receiver to the L-plug (horizontal
spacer).

Attach the radio antenna to the antenna connector (for RTK only).
Carefully level the tripod and tighten the screws.

Attach any other accessories as needed (for example, a backup
power supply).

HiPer Ga/Gb Receiver

Horizontal Spacer

Tribrach Adapter (Precision)

Universal Tribrach

Figure 4-1. Install Tripod and Receiver over Control Point
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To set up the Rover receiver (Figure 4-2):

1. Attach the receiver to the pole, locking it into place.

the antenna/receiver does not move during data

@ Use a bipod during post-process surveys to ensure
logging.

2. Attach the radio antenna to the antenna connector (for RTK only).

Figure 4-2. Connect HiPer Ga/Gb Receiver to Bipod
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Step 2: Measuring Antenna Height

The location of the antenna relative to the point being measured is
very important for both surveys in which the elevation of the points is
important and in surveys for horizontal location only. Horizontal
surveys are often larger in area than can reliably fit on a flat plane;
therefore, the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center.
To determine the coordinates of the station marker, specify the
following:

* Measured height of the antenna above the station marker
* Method of measuring the antenna height
* Model of the antenna used

Antennas have two types of measurements:

¢ Vertical — measured from the marker to the antenna reference
point (ARP) located on the bottom of the receiver at the base of
the mounting threads.

* Slant — measured from the marker to the lower edge of the
antenna slant height measure mark (SHMM) located on both end
panels of the receiver.

The surveying point that GPS/GLONASS measures is called the
“Phase Center” of the antenna. The Phase Center is analogous to the
point that a distance meter measures in a prism. Enter the prism
offset to compensate for this point not being at a physical surface of
the prism. For a GPS/GLONASS antenna, the offset entered depends
on the type of measurement taken.

* For vertical, the offset is simply added to the measured vertical
height to produce a “true” vertical height.

* For slant height, the vertical height must first be calculated using
the radius of the antenna, then the offset can be added.

The offsets are different because of the difference in location between
the slant measuring point and the vertical measuring point.
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To measure the antenna height:

1. Measure the antenna height above the control point or marker,
either the slant height or the vertical height (Figure 4-3).

Slant Height
to SHMM

Vertical Height
to ARP

Station Marker
or
Tip of RTK Pole

Figure 4-3. Antenna Offset Measurements

* SHMM to ARP vertical offset = 30.50mm
* SHMM to ARP horizontal offset = 77.75mm
Table 4-1 gives the offset values for the receiver.
Table 4-1. HiPer Ga/Gb Antenna Offset Measurements

To L1 Phase Center To L2 Phase Center

Up 105.9mm 97.1mm

2. Record the antenna height, point name, and start time in the field
notes.
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Step 3: Collecting Data

See the remaining sections in this chapter for more information on
collecting data.

1.

Turn on the receiver. The STAT (status) light (LED) initially
blinks red.

Once the receiver has locked on to one or more satellites, the
STAT light blinks green for GPS satellites and orange for
GLONASS satellites. A short red blink indicates that the receiver
has not solved a position. Four or more satellites provide optimal
positioning.

Once the short red blink is gone, the receiver has a position and
surveying can begin; wait for green and orange lights before
beginning data collection. This ensures that the receiver has the
correct date and time, and is locked on to enough satellites to
ensure good quality data.

The process of locking on to satellites normally takes less than
one minute. In a new area, under heavy tree canopy, or after
resetting the receiver, it may take several minutes.

To begin collecting data, press and hold the FN key (for more
than one second and less than five seconds).

Release the FN key when the REC (recording) LED turns green.
This indicates that a file has opened, and data collection has
started. The REC LED blinks each time data is saved to the
internal memory.

| Use PC-CDU to configure data logging. See
% “MINTER Configuration” on page 3-17 or refer to

the PC-CDU Reference Manual.

When finished, press and hold the FN key until the REC LED
light goes out.

To turn off the receiver, press and hold the power key until all
lights go out, then release.
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MINTER Operation

The MINTER is the receiver’s minimum interface used to display and
control data input and output (Figure 4-4).

Power Button Reset Button
Status LED Battery LED

Y- P

@ STAT
o

@)

N REC B c : usB PWR 2

/@T)\ Serlal Po'rts /(T))
Record LED Modem Status LED

FN Button
Figure 4-4. HiPer Ga/Gb MINTER
The MINTER performs numerous functions, including the following:
* Turns the receiver on or off.
* Turns data recording on or off (FN key).
» Changes the receiver’s information mode.

* Shows the number of GPS (green) and GLONASS (orange)
satellites being tracked (STAT LED).

» Shows the data recording status and each time data is recorded to
internal memory (REC LED).

» Shows the status of post-processing mode (static or dynamic)
during a post-processed kinematic survey (REC LED).

» Shows the status (high charge, intermediate charge, or low
charge) of the battery (BATT LED).

» Shows the power status for the receiver (BATT LED).

* Shows the status of the modem and if it receives signals (RX TX
LED).

* Shows Bluetooth activity (BT LED).
See “MINTER” on page 1-8 for a full description of the MINTER.
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To turn on/off the receiver, press the power button (Figure 4-5).

* When turning on, press the power button until the MINTER’s
LEDs briefly flash.

* When turning off, press the power button until the LEDs go out,
then release.

Press the power button for about 1
/ second to turn the receiver on/off.

©

TT

@)
S
@ Serlal Puvrts @

Figure 4-5. Power Button Functions

To start/stop logging data, press the FN button for 1 to 5 seconds
(Figure 4-6).

* During data recording, the REC LED is green. Use PC-CDU to
set the recording time interval. See “Recording Interval
parameter” on page 3-20 for details.

* The REC LED blinks green each time data is written to the
internal receiver’s memory.

* If the REC LED is red, the receiver has run out of memory, has a
hardware problem, or contains an improper OAF (see “Option
Authorization File (OAF)” on page 1-20 for more information).

Use PC-CDU to enable the desired FN key mode in the receiver,
either “LED blink mode switch” for static surveys or “Occupation
mode switch” for kinematic surveys. See “FN Key Mode parameter”
on page 3-22 for details.

Each time you turn off or on data recording, either a new file
opens or data appends to a particular file. See “Always Append to
the File parameter” on page 3-20 and “Files Creation Mode
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parameter” on page 3-21 for information on setting these
functions.

RESET

© ©
o ®0O O@E o
REC B c D usB PWR RX
@ Serial Puvrts @

\— Press the FN button for 1-5
seconds to start/stop data logging.

Figure 4-6. FUNCTION Button Functions

To toggle between post-processing modes, press the FN key for
less than 1 second when “Occupation mode switch” has been enabled
using PC-CDU.

To change the information mode of the receiver, press the FN key
for less than 1 second when “LED blink mode switch” has been
enabled using PC-CDU.

To change the baud rate of the receiver’s serial port, press the
FN key for 5-8 seconds. This is useful if the data collector does not
support the rate that the receiver port is set to.

After about five seconds, the REC LED becomes red. Release the FN
key during the next three seconds.

Static Surveying for Base
Stations

Static surveying is the classic survey method, well suited for all kinds
of baselines (short, medium, long). At least two receiver antennas,
plumbed over survey marks, simultaneously collect raw data at each
end of a baseline during a certain period of time. These two receivers
track four or more common satellites, have a common data logging
rate (5-30 seconds), and the same elevation mask angles. The length
of the observation sessions can vary from a few minutes to several

P/N 7010-0816 4-9



HiPer Ga/Gb Receiver Setup and Survey

hours. The optimal observation session length depends on the
surveyor’s experience as well as the following factors:

* The length of the baseline measured

* The number of satellites in view

* The satellite geometry (DOP)

* The antenna’s location

* The ionospheric activity level

* The types of receivers used

* The accuracy requirements

* The necessity of resolving carrier phase ambiguities

Generally, single-frequency receivers are used for baselines whose
lengths do not exceed 15 kilometers (9.32 miles). For baselines of 15
kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-
frequency receivers can estimate and remove almost all ionospheric
effect from the code and carrier phase measurements, providing much
greater accuracy than single-frequency receivers over long baselines
or during ionospheric storms. Secondly, dual-frequency receivers
need less observation time to reach the required accuracy.

After the survey completes, data the receivers collect can be
downloaded onto a computer and processed using post-processing
software (for example, Topcon Tools).
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Kinematic (Stop & Go)
Surveying for Rover Stations

In a kinematic stop and go survey, the stationary receiver (Base
station) is set up at a known point, such as a survey monument, or an
unknown point. The receiver continually tracks satellites and logs raw
data into its memory. The Rover receiver is set up at an unknown
point and collects data in static mode for 2 to 10 minutes. When
finished, assign the Rover to kinematic status and move to the next
survey point. At this point, and each subsequent point, the receiver
changes to static mode to collect data. The Rover is in kinematic
mode when moving. The Rover is in static mode while collecting
data.

To set up kinematic surveying for Rover Stations:

1. Set up the Rover at an unknown point, and press power. Allow
the Rover to collect static data for two to ten minutes. The REC
LED will be orange.

Check the STAT light for satellites tracked.

3. When finished, press the FN key for less than 1 second to assign
the Rover to kinematic.

| Remember, if the REC LED blinks green, the
% current mode is dynamic, if it blinks orange, the

current mode is static.

4. Move the Rover to the next location (survey point), and press the
FN key for less than a second to collect the data in static mode for
two to ten minutes.

5. Repeat steps three and four until all points are surveyed. The
occupation time for the points depends on the same factors as for
the static survey method.

6. When finished, press the FN key for one to five seconds to stop
logging data. Turn off the Rover if needed.
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This method of GPS survey allows the operator to reduce the point
occupation time, thus permitting field crews to survey many more
points compared to the other methods available.

Real Time Kinematic
Surveying

In RTK surveying, one receiver serves as the reference station. The
receiver conducts observations with its antenna affixed to a stationary
tripod or another device. The second receiver functions as a rover and
conducts observations (using an antenna) affixed to a mobile pole and
moved to observation points.

Unlike post-processed kinematic surveys, RTK surveys use a
communications link between the Base and Rover. Using a radio
modem link, the Base receiver transmits its measurement and location
data to the Rover receiver. The Rover, based on the transmitted data
and its own observation data, immediately conducts a baseline
analysis and outputs the results. For specific settings used in RTK
surveys, see “Configuring the Radio Modem” on page 3-3 and
“Configuring the Receiver” on page 3-7.

If using PC-CDU to monitor an RTK Rover receiver, check the LQO
field on the main screen (Figure 4-7 on page 4-13) to ensure the
receiver obtains differential corrections. Usually, the receiver starts to
output the coordinates of the antenna’s phase center along with the
solution type within 10-30 seconds; however, spread spectrum radios
and GSM phones may take as long as 60 seconds to synchronize.

The geodetic coordinates displayed on the Geo tab are always
computed in WGS84 and have four solution types.

» Standalone — where the receiver computes 3D coordinates in
autonomous mode without using differential corrections.

* Code differential — where the Rover receiver computes the current
relative coordinate in differential mode using only pseudo ranges.

* RTK float — where the Rover receiver computes the current
relative coordinates in differential mode using both pseudo ranges
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and phases; however, with a float solution, the phase ambiguity is
not a fixed integer number and the “float” estimate is used
instead.

* RTK fixed — where the Rover receiver computes current relative
coordinates, with ambiguity fixing, in differential mode.

The LQ field reflects the status of the received differential messages
and contains the following information:

* Data link quality in percentage

» Time (in seconds) elapsed since the last received message

* Total number of received correct messages (dependent on the
message type received)

* Total number of received corrupt messages (dependent on the
message type received)

If the receiver is not (for some reason) receiving differential
corrections, or if none of the ports have been configured to receive
differential corrections, the LQ field is either empty or looks like this:
100% (999,0000,0000).

[EdPc-cou to GR3 IDRBPTIIQGAGW (rover) =10l

File Configuration Tools Plots  Help

GPS Satellites [3)

w | EL[ ez|calPilrz] Tc] ss|
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5
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E
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[
L}
4

a0-
55+
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55+

a0-

Geo vz | Target]
Lat: 55°43'18.7161" N
Lor: 37° 39'06.1461"E
At 166.2720m
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RIS Pos: 0.0158 m

RMS Vel 0.2114 mis
FOOP: 17286

BT fized
LLJ: 1007 [D00,0363,0000]

Recaiver time: 14:17.05
Recaiver date: 08,06, 2006
Clack offset: -0.8633 ppm
Osc. offset:  -0.8633 ppm
Tracking time: 00:06:17

GLONASS Satellites [6)

sn|Fn] EL] az[calFi[pz] 1e] ss|
m

07 54+ 286 40 41 47 4 BAs
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Notes:
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Chapter 5

Receiver and File
Maintenance

If post-processing the data after completing a survey, then the data in
the receiver’s memory needs to download to a computer.
Downloading and deleting files prepares the receiver’s memory for
the next survey. Occasionally, the receiver’s NVRAM may need to be
cleared to eliminate communication or tracking problems.

As project expectations expand, the receiver’s OAF may need to be
updated to provide expanded operation and functionality. The various
boards inside the receiver (GPS, power, modem, and Bluetooth)
require firmware to properly operate and provide appropriate
functionality. As TPS releases firmware updates, loading these
updates into the receiver will ensure the receiver operates at its full
potential.

Downloading Files to a
Computer

After completing a survey, download data files to a computer for
storage, post-processing, or backup. Also, the receiver memory holds
a finite amount of files and information, so downloading data prevents
files from being lost. PC-CDU and Topcon Link both provide file
managers to download files from the receiver to your computer and to
delete files from the receiver. PC-CDU Lite and Topcon Link are both
free utilities available via your Topcon Dealer or the Topcon website
(www.topconpositioning.com).
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Downloading Files via Topcon Link

Topcon Link provides two options for downloading files from a
receiver: via Windows® Explorer or via the Topcon Link interface.

Before you can download files, connect your receiver and computer
(see “Connecting the Receiver and a Computer” on page 2-14 for this
procedure).

...Using Windows Explorer
Perform the following to download files using Windows Explorer:

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for more information.

2. Open Windows Explorer, and click the Topcon Receiver folder.
The right panel of the window displays the automatic start of
searching for Topcon receivers connected to any of the computer
ports (COM and USB) (Figure 5-1).

When finished, all receivers connected to the computer ports
(Figure 5-1) are displayed.

| ] Topcon Receivers

File  Edt Wew Favortes Tools  Help I
QBack ] 5 7 ) search | [ Falders
Address | &) Topcan Receivers v B
Falders s %
# &) Topcon Recsivers ~
H & To Total Skations .
2 Topcon
5 62 oy Hotwerk e Ko receivers found
2 Recycle Bin Stop
@ E My Blustooth Places 3
-
Address | ) Topeon Receivers B>
Folders x & &7 <)
= o ~

Search for HE_GD HIPER
conneck, ..

<& HIPER
® & Topcon Total Stations
# % My Network Places
o oD

v

Figure 5-1. Searching and Finding Topcon Receivers in Windows Explorer

3. To stop searching for receivers when the receiver has been found,
click Stop. Only the discovered receivers display.
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® Topcon Receivers

File Edit View Favorites Took Help '
> ®) =,
Qe - () T O seach [ Focers Favortes  Tooks  Help a
Actiress &) Topeon Recsivers v B WD seanh [ rolders
Folders B -
v
4 Topcon Digital Levels ~ 2 sceivers | B
£ Topeon Recsivers = a‘ -
2 Topcon Total Stations There are 1 new receiver(s) found. fallows & <7
) My Network Places % Search for HIPER,
2l Recycle Bin —Up[g connect...
My Blustaoth Places v i Stations
©3 My Network. Places E
# Recyrls Bin v

Figure 5-2. Break Of Searching Receivers
4. To update information about the receivers connected to the
computer port, click Search for connected receivers.

5. To view information about the receiver (Figure 5-3), right-click
the receiver, and select the Properties option.

6. To view the raw file, click on the receiver.

Properties E|

% Topcon Receivers ERE |§‘ REeelar PIEEES I

File Edt View Favorites Toos Help &

Qe - @ - (T O search [ Folders Receiver:

Address | &) Topeon Recefvers v B Model: HE_GD

Falders = & . D 222333BBEER

&) Topcon Receivers ~
= Port: comt
r— Searchfor [
connect... Transfer options fie...

& Topcon Total Stations

& 1y Netwark Places -
2 Recycls Bin

Figure 5-3. Receiver Properties

<

(213 Cancel | ‘

7. To import the file(s) from the receiver to a folder, select the

file(s), and copy to the folder using the drag-and-drop method
(Figure 5-4).

File Edt Wiew Faworites Tooks  Help

eBack - @ - J} /.-"Search

Address |2 HIPER v

Downloading file logl e tps

I.E Folders

Downloaded 4096 bytes of 5227

Tianser rate is 4096 bytes/sec

T oo = @@ #]  #] | annnnnunnnnERRERRERRENE

[ ) Topeon Link Data 101b.tps log0i0ictps logDlle.tp

@ Topcon Tools Data m;n];m o
| >

<

Figure 5-4. Start of File Import from the TPS Receiver/Import in Progress
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...Using Topcon Link

To download files using Topcon Link:

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

To start Topcon Link, click Import from Device on the Toolbar.

3. From the left panel of the Import from Device dialog box,
double-click Topcon Receivers (Figure 5-5).

= Import from Device @gl

Lookin | 1 My Computer - «|m| e

lokin  [Rawasa -] @[y

[ Moblle Device
4 Tapcon Digital Levels
L4 Topeo /8rs

& Topcon Total Stations

i

(From _Met

& log0101b.tps
& log0101c.tps
& logD101e tps
& log0314a.tps

Cloze

Figure 5-5. Import From Device Window

The program automatically searches for Topcon receivers
connected to the computer ports (COM and USB). When finished
all receivers connected to the computer ports (Figure 5-6) display.

1~ Import from Device
Lok ir: &) Topoon Receivers JJ

2

Stap

|

Searching... I

H Import from Device
Lok in ) Topcon Rieceivers JJ

Search for connected receivers
<7 HE_GD
<7 HIPER.

Figure 5-6. Search for Topcon Receivers

4. To view information about the receiver, right-click the receiver
and select the Properties option (Figure 5-7 on page 5-5).

5-4

HiPer Ga/Gb Operator’s Manual



5.

Downloading Files to a Computer

kA Import from Device Properties 3]
Lonk in' [&)Tapean Freceive =] 4| 1| 2 Recatver prperes |
[@search for connected recevers

<7 HE_GD
|

Select Receiver:
Transfer opians fiie k | Madel HE_&D
D: 222333BBEBE
Port: COmM1

Figure 5-7. Receiver Properties

In the right panel of the Import From Device window, navigate to
and select, or create, a folder in which to save the files (Figure 5-
8).

To view the collected raw file, double click (or click Select in the
pop-up menu) the receiver. To import the file(s) from the receiver
to the computer and to save in the selected folder, highlight the
file(s) and click the double arrows (Figure 5-8).

The import progress bar displays (Figure 5-8).

&A Import from Device ‘E‘E|
Look in: |2 HIFER - ﬂJ Lookin: |CJRaw data - ﬂ@
#] 1 tps 1#]logzo04113 [Sfrom _Met

|#7 lg0101a.tps |#]logz004113 . log0101b, tps

B logD225a.tps ﬁ, log0L01c.tps

B lng0304a.tps

[#] lagoan4b.tps

@ log20041117_51538.tps
B logz0041117_S1710.tps
B log20041130_2942.tps

4 |

log0225h.tps N £ logD101e tps
E lng0228a.tps ﬁ, lng0314a.tps

o Progress...

Diownloading file log0304b.tps

|

Diownloaded 137216 bytes of 12003568

Close Transfer rate iz 8071 bytes/sec

|

Figure 5-8. Select the Raw Data File to Import and View Import Progress
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Downloading Files via PC-CDU
To download files via PC-CDU:

1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

Open PC-CDU.

On the Connection Parameters dialog box, enable RTS/CTS
handshaking, and click Connect (Figure 5-9).

[ Connection Parameters ]

Connection mode:

€ Intenet Client

" Intemnet Server |

~Pot setting:

Part: [COM1

|

[¥ RTS/CTS handshaking

Baud rate; [ 115200

7| ™ Inirared port

y A

Frogram setting:

[~ Passivermode [ ﬂanua\ mode only  Timeout [ms]: | 500 =

original baud rate on Disconnect

[¥ RTS/CTS handshaking

elling:

TEF gart: [a000

Password; |

[* Displaydetacnsever  [# Logseverevents [ DN lookup
ﬁ Ennne:tr:! Cancel

Figure 5-9. Connection Parameters — RTS/CTS Handshaking

4. Click File » File Manager, and then the Download path tab on
the File Manager dialog box (Figure 5-10).

EﬂFile Manager

Download files | Current log file | Downlot§ pathl

Tatal memory: 47348784 bytes

X

Free memony: 47164824 bytes

Mame Size | [ate | Time
log9233 75196 23.09.2002 G:4%:52
log0923b FET95  23.09.2002 851:53
log0924a BEET  24.09.2002 35251
log0924b 4701 24.09.2002 35259
log0924:c 4933 24.09.2002 G5%44
log0924d 5190 24.09.2002 G5%55
log0924e 4676 24.09.2002 554:06
log0324f 4162 24.09.2002 35416

Saveto: EATESTINGNDATA

Using: | Current port [COM2] = | Block size: |512 bytes -

Refresh I

Downloadl Delete |

I~ Exclusive mode

Exit |

[

Figure 5-10. Find Files to Download

5. Navigate to or create (using the Create button) the folder in
which to download and store files.
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6. Click the Download files tab, and select the file(s) to download
(Figure 5-11 on page 5-7).
To select multiple files, press the shift key while clicking non-
sequential files or press the Ctrl key and click individual files.
£

Deownload files | Current log h\el Dowanload Dathl

Total memory: 47348784 bytes Free memony: 47164824 bytes

35253
3:63:44

Save to: EATESTINGADATA

| I~ Exclusive mode
Using IEunEnl poit [EDMZ]j Block size: I512hytes d
ann\oadl Delete | Hefresh I Exit |

o

Figure 5-11. Download Files

7. Click Download. During the download, status indicators display
next to each file (Figure 5-12).
* Blue indicator — file in queue for downloading.
* Red indicator — file currently downloading.
* Green indicator — file has successfully downloaded.

x
Daownload files | Current log Fi\el Dawrload Dathl
Tatal memory: 47348784 bytes Free memarny: 47164824 bytes
MName | Size | Date | Timne:
® |og0923a 7A196  23.09.2002 84552
@ |og0923k TEFEE  23.09.2002 8:51:53
© |og0924a BEE1  24.09.2002 F52:51
® |og03z4b 4701 24.09.2002 35253
loal924c 4933 24.09.2002 35344
lng0924d 5180 24.09.2002 36355
lnal924e 4676 24.09.2002 F54:06
log324f 4162 24.09.2002 35416

Save to: EATESTIMGADATA
| Blocks: 28 I™ Exclusive mode
Using: ICurrent poit [CDMZ]j Block size: |512b_utes j
Stop I [elete | Eiefresh I Exit |
’W| Downloading logd923a. ..

Figure 5-12. Download Files — Status Indicators
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8. When done, click Exit on the File Manager dialog box.

9. Continue with other operations, or click File » Disconnect and
then File » Exit to quit PC-CDU.

Deleting Files from the
Receiver

To delete files from your receiver.
1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

2. On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 5-13).

[ Connection Parameters B
Connection mode
(r-‘ Direct © Intemet Client © Intemet Server |
[~ Port setting:
Por: [comM1 =] Baudrate: [115200 | I Inirared port

[¥ RTS/CTS handshaking
|

Program sefting /

[~ Passive mode rﬂanua\mudem\y Timeout [ns) [500 =

original baud rate on Disconnect

[ RTS/CTS handshaking s

TER park | 2000

Password |

= Displaydataonisever ¥ Logsemver events = DHS [ookup
Cancel
Figure 5-13. Connection Parameters — RTS/CTS Handshaking

3. Click File » File Manager, and select the file(s) to delete on the
Download files tab (Figure 5-14 on page 5-9).

To select multiple files, hold down the shift key and click on non-
sequential files to select several files at once or hold down the
Ctrl key and click on individual files.

Click Delete (Figure 5-14 on page 5-9).

5. Click Yes at the delete files confirmation dialog box. PC-CDU
deletes the selected files.

6. Click Exit on the File Manager screen.

7. Continue with other operations or click File » Disconnect, and
then File » Exit to quit PC-CDU.

5-8 HiPer Ga/Gb Operator’s Manual



Managing Receiver Memory

M

Download files | Current lng fi\el Dowrload pathl

Total memony: 47348784 bytes Free memony: 47164824 bytes

log0324b 4701 24.09.2002
43 2

Save to: EATESTINGYDATA

| I~ Exclusive mode
Using: ICurrent port [COMZ) j Block size: |512 bytes j
ann\oadl Dale,lew Refresh I Exit |

[

Figure 5-14. Delete Files

Managing Receiver Memory

When using the receiver in static or dynamic applications, you may
need to know the amount of memory the receiver’s log file occupies.
The specific memory size depends on the type of data being recorded.
Use the formulas below to compute the approximate size of the
receiver’s log files. These equations are based on the default set of
messages.

* SS — the estimated size of one epoch of raw data in the receiver’s
log file (expressed in bytes).

* N — the number of observed satellites per epoch.

When recording only L1 data:
SS =183 + 22*N

When recording L1 and L2 data:
SS =230 + 44*N
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Managing Receiver Options

The Option Authorization File enables certain functions, features, and
options in the receiver, such as the following:

* the type of signal (L1, L1/L2, and so on) the receiver processes
* the amount of data the receiver stores in the memory
* the rate at which data is transmitted or received

For a complete list of available options and details, consult with your
TPS dealer.

Checking the Receiver’s OAF

Use PC-CDU to view the status of the receiver’s options.
1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

2. Click Tools » Receiver Options. The Options Manager dialog
box (Figure 5-15 on page 5-11) contains the following
information:

* Option name — a name/description of the option
* Current — the current status of the option

* Purchased — if the option is purchased or not

» Leased — if the option is leased or not

» Expiration date — the date the option will be disabled, if
applicable

Since Options can be both purchased and leased, the “Current”
status of the option displays the currently effective value. Option
values can be one of the following:

* -1 or “-----” — the firmware version does not support this
option

* 0 — the receiver option is disabled

* positive integer — the option is enabled

* yes or no — the option is either enabled or disabled
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3. When finished, click Exit on the Option Manager dialog box,
then click File » Disconnect to disconnect from PC-CDU (and
prevent conflicts with serial port management).

ﬁ, Option Manager - IEI Iil

Option name Current | Purchased |  Leased | Exp. date ||
Tools GPS yes yes no
Initialize file system E1LDNASS ﬁ:z ﬁ:z :E
Clear NVRAM L2 ves ves no
Reset receiver Cinderella yes yes no
—_— Position update rate [Hz] 20 20 1]
Fiaw data update rate [Hz] 20 20 1]
Code differential Baze yes yes no
Code differential Rover yes yes no
RTK Base yes yes no
RTK Rover [Hz] 20 20 1]
Memory [Mb] 7B 7B 1]
Co-0p Tracking yes yes no
1-PPS Timing Signal 2 2 1]
Ewvent Markers 2 2 1]
In-Band Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency [nput yes yes no
Freq. Lock and Output yes yes no
Serial Port A [Kbps] 460 460 1]
Serial Port B [Kbpsg] 460 460 1]
Serial Port C [Kbps] 460 460 1]
Serial Port D [Kbps] 460 460 1]
Infrared Part ho ho ho
Parallel Port e ho ho
Sp.Sp. Freq. Hop. no no no
Sp.Sp. Direct no no no
Falk yes yes no
[ratumsz support yes yes no
Magnetic azimuth yes yes no

Geoid height yes yes no —
‘Way Point Mavigation e yes no

WAKS yes yes yes 8/1/2001

OMMISTAR s yes no
RTCH Output 3 2 1]
RTCH Input 2 2 1]
ChA Dutput 1 1 1]
CA Input 1 2 1]
JPS Output 1 1] 1]

JPS Input 2 0 0 LI

Fiefrezh | Load | Stop | Exit |
| y

Figure 5-15. View Option Manager
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Loading an OAF

Topcon Positioning System dealers provide customers with OAF
files. For any OAF related questions, e-mail TPS at
options@topcon.com and include the receiver’s ID number (see the
bottom of the receiver for the ID).

1.

To load a new OAF, follow steps one and two in “Checking the
Receiver’s OAF” on page 5-10.

Click Load at the bottom of the Option Manager dialog box (see
Figure 5-15 on page 5-11).

Navigate to the location of the new Option Authorization File.

OAFs have .jpo or .tpo extensions and are unique to each receiver
(Figure 5-16).

Select options file 2%

Lok in: I :__*fj Desktop

r-A My Documents
= My Computer
K= My Metwork Places

File name: 4 F20 08N 4U5

Open

Filez of type: IJPS Options files j Cancel

Figure 5-16. Load OAF

Select the appropriate file, and click Open (Figure 5-16). The
new receiver option loads onto the receiver, and the Option
Manager table updates.

When finished, click Exit on the Option Manager dialog box,
and then click File » Disconnect to prevent conflicts with serial
port management.
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Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM)
holds data required for satellite tracking, such as ephemeris data and
receiver position. The NVRAM also keeps the current receiver’s
settings, such as active antenna input, elevation masks and recording
interval, and information about the receiver’s internal file system.

Even though clearing the NVRAM is not a common (nor normally a
recommended) operation, there are times when clearing the NVRAM
can eliminate communication or tracking problems. Clearing the
NVRAM in your receiver can be interpreted as a “soft boot” in your
computer.

After clearing the NVRAM, the receiver requires time to collect new
ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files
already recorded in your receiver’s memory; however, it will reset
your receiver to factory default values.

In addition, the NVRAM keeps information about the receiver file
system. Note that after clearing the NVRAM, the receiver's STAT
LED flashes orange for a few seconds, indicating that the receiver is
scanning and checking the file system.

Using the MINTER to Clear the
NVRAM

1. Press the power key to turn off the receiver.
Press and hold the FN key.

3. Press and hold the power key for about one second. Release the
power key while continuing to hold the FN key.

. Wait until the STAT and REC LEDs are green
5. Wait until the STAT and REC LEDs blink orange.
6. Release the FN key while the STAT and REC LEDs blink orange.
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Using PC-CDU to Clear the NVRAM

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

2. Click Tools » Clear NVRAM (Figure 5-17).

Initialize file system

Reset receiver [ g

Receiver options

Figure 5-17. Clear NVRAM with PC-CDU

While the NVRAM clears, the REC LED flashes green and red; the
STAT LED flashes red. The receiver automatically disconnects when
finished.

Changing Receiver Modes

The receiver has the following information and power modes:
* Normal Mode — the standard surveying mode.

» Extended Information Mode — used for testing purposes during
normal operation.

* Sleep Mode — used to stop recording data, but keeps the receiver
powered on “standby.”

» Zero Power Mode — used to prevent battery discharge.

Entering Extended Information Mode

Extended Information Mode (EIM) is used for receiver testing
purposes. In this mode, the receiver continues to work as usual, but
the STAT LED indicates “extended” information using a delimiter.

The Delimiter is a distinguishable double-blink that shows the overall
status of tests performed in EIM. The STAT LED color for delimiter
is calculated from the colors of other LED blinks, and becomes one of
the following colors when the tests complete:

* Orange — at least one blink is orange.
* Red — no orange blink and at least one red blink.
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¢ Green — all other cases.

The delimiter double-blink is followed by six LED blinks
corresponding to six receiver tests, where each blink indicates the
following information:

Blink 1. Sufficient data for position computation.
Blink 2. GPS S/N ratios are good (Table 5-1).
Blink 3. GLONASS S/N ratios are good (Table 5-1).

Blink 4. Oscillator’s frequency offset is less than three ppm (parts
per million).

Blink 5. Oscillator's Allan Variance is better than 2.7e-10
(currently, always orange).

Blink 6. Continuous tracking time is more than 15 minutes.

Table 5-1. Signal-to-Noise (S/N) “Good” Ratios

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

The color of the blink indicates that information for test is unavailable
(orange), the receiver passed the test (green), or the receiver failed the
test (red).

1.

P/N 7010-0816

To switch to EIM, press and quickly release (within one second)
the FN key on the MINTER.

Watch for the delimiter double-blink. With good receiver,
antenna, and observation conditions, all blinks should be green
within 15 minutes of powering on.

¢ Green — ok
* Orange — wait
¢ Red — some tests failed

To switch back to normal mode, press the FN key.
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Entering Sleep (Off) Mode

In sleep mode, the power board and Bluetooth module continue to
draw power from the batteries, causing the batteries to drain over
time. Sleep mode is the normal “off” state of the receiver.

1. Turn on your receiver.

2. Press the receiver’s power key for more than four seconds and
less than eight seconds. The STAT and REC LEDs will be orange.
The receiver enters Sleep Mode.

3. Any activity on the RS232 port turns on the receiver.

If you press the power key for more than 14
@ seconds, then the pressure will be ignored. This

operation protects the receiver from stuck keys.

Entering Zero Power Mode

When the receiver is off, even in Sleep Mode, the power board
continues to draw power from the batteries. This means that if you
fully charge your receiver, turn it off and store it, the receiver will
drain its battery power in less than two months. To stop the various
boards and modules from draining the batteries, put your receiver in
Zero Power Mode.

1. Turn on your receiver.

2. Press and hold the power key for more than 8 seconds but less
than 14 seconds.

3. Release the power key when both LEDs become red. When the
LEDs turn off, your receiver will be in Zero Power Mode.

4. Press the Reset key for about one second to return to Normal
mode.

discharged and no external power is connected, the
receiver will go into Zero Power Mode to prevent
the batteries from over discharging.

@ When the internal batteries have completely
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Loading New Firmware

Base and Rover receivers must be loaded with the same firmware
version. Use the latest firmware version, available for download from
the TPS website at www.topconpositioning.com to ensure your
receiver has the most recent updates.

The HiPer Ga/Gb receiver must be loaded with
firmware version 3.0 or newer.

&>
gitp

Do not attempt to load firmware older than 3.0.

The receiver board and power board must be loaded with firmware
from the same package. The Bluetooth module’s firmware is
independent of the receiver card and power board, and has a different
firmware package.

The receiver uses FLoader, a Windows®-based utility, to load
firmware onto the receiver and power boards. You can download
FLoader to your computer from the TPS website at
www.topconpositioning.com. For more information, refer to the
FLoader User’s Manual, also available on the TPS website. See
“Installing FLoader” on page 2-6 for installing FLoader on the
computer.

To load new firmware:

1. Download the new firmware package to your computer.

2. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-14 for this procedure.

3. Start FLoader.

4. On the Connection tab, select the COM port on your computer

that connects with your receiver and select its speed (usually
115200) (Figure 5-18 on page 5-18).
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5. See “Loading Receiver and Power Board Firmware” on
page 5-18 to load the appropriate firmware.

TPS Firmware Loader: Device = Receiver i =l

File Options Help

Cannection | Device | Program |

Connection Type: Serial Cable

Connection Setting:

PLC Part: IEDM‘I 'l ‘wiord Length: IS 'l
Baud rate: |1152DD 'l Parity: INone 'l
Handzhaking: INone 'l Stop Bits: I‘I 'l

|25 il 200z [16:08.11

Figure 5-18. FLoader Main Screen

Loading Receiver and Power Board
Firmware

Receiver and power board firmware is released as a compressed file to
download and decompress. This file contains the following three files:

* ramimage.ldr — the Receiver board RAM file
* main.ldp — the Receiver board Flash file
* powbrd.ldr — the Power board RAM file

These files must come from the same firmware

@ Load all three files when loading new firmware.
package.
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1. In FLoader, click the Device tab, and set the Device Type to
“Receiver.” Click Get from Device for device information
(Figure 5-19).

ETF‘S Firmware Loader: Device = Receiver

File Options Help

Connection  Device IF‘rogramI

Device Type: Receiver 'l

Device Information

Model:

1D:

Firmivare
Hardware:
RAM Size, KB:

Savelofie I Cancel I

[31 Mar 2003 [17:532.44

Figure 5-19. Set Device Type

2. Click the Program tab, and set the Capture Method to “Soft
Break Capture” (recommended) (Figure 5-20 on page 5-19).

E TPS Firmware Loader: Device = Receiver
File Options  Help
Connactionl Device Program ]
Capture Method: | Soft Break Capture hd
Firrnware
@ RAM file: |C:\FLDadeLFirmware j Browse B
& Flash file: |C-\FLoader_Fimuiare | BuowseF
= Cancel |
Ready 08 Jun 2006 |15:57.38

Figure 5-20. Program Tab Settings

3. Browse for and select the receiver board’s RAM file and Flash
file (Figure 5-20).
4. Click Load and wait until 100% of the files load into the receiver.

displays at the bottom of the dialog box. Select the

@ If you selected an incorrect file, an error message
correct file.
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5. Click the Device tab, and set the Device Type as “Receiver’s
Power Board.” Click Get from Device for device information
(Figure 5-21).

ETF‘S Firmware Loader: Device = Receiver's Power Board =100 ]

File Options Help

Connection  Device IF‘rogramI

Device Type: Receiver's Power Board 'l

Device Information

Firmware
Hardware:

Savelofie I Cancel I

|Ready |31 Mar 2003 [17:55.40

Figure 5-21. Set Device Type

6. Click the Program tab, and set the Capture Method to “Soft
Break Capture” (recommended) (Figure 5-22).

TPS Firmware Loader: Device = Receiver's Power Board E]‘Elg‘
File ©ptions Help

Ennnectim} Device Program ]

Capture Method: |Soft Break Capture -
Firrnware
@ RAM fle: |C:AFLoader_Firmweare j Browze B

Cancel ‘

05 Jun 2006 [15:58.51

Figure 5-22. Program Tab Settings

7. Browse for and select the Power board’s RAM file (Figure 5-22).

8. Click Load, and wait until 100% of the power board file loads
into the receiver.

displays at the bottom of the dialog box. Select the

@ If you selected an incorrect file, an error message
correct file.
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9. Click File » Exit.

10. Clear the receiver’s NVRAM (see “Clearing the NVRAM” on
page 5-13) and update the almanac (see “Collecting Almanacs
and Ephemerides” on page 2-21) after loading new firmware.

Loading Bluetooth Module Firmware

Bluetooth module firmware is released as a compressed file that you
download and decompress. This file contains the following two files:

* btloader.ldr — the Bluetooth module RAM file
* btmain.ldp — the Bluetooth module Flash file

You must load both files when loading new
@ firmware. These files must come from the same

firmware package.

1. In FLoader, click the Device tab, and set the Device Type as
“Receiver.” Click Get from Device for device information
(Figure 5-23).

ETF‘S Firmware Loader: Device = Receiver

File Options Help

Connection  Device IF‘rogramI

Device Type: Receiver 'l
Device Information

Model: HIFER

1D: BROINOWOOSG
Firmware 25 Feb 21,2005
Hardware: HGGDT_&

BAM Size, KB: 4096

Cancel I

Get from Davical LSavelofie

|Ready [15 Mar 2005 [18:3252

Figure 5-23. Get Device Type

2. Click the Program tab, and set the Capture Method to “Soft
Break Capture” (recommended) (Figure 5-24 on page 5-22).

3. Browse for and select the Bluetooth module’s RAM file and Flash
file (Figure 5-24 on page 5-22).
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TPS Firmware Loader: Device = Receiver

File Options Help

Connection | Device Pfﬂgfﬂml

Capture Method: ISoFt Break Capture -

 FiAM file: [E:\...\bi_hgd]_ 01 3btloader Idh 7| Browss Rl

% Flash file: IE:\.. “Firmware and loaderibt_hgdl_013%btmain.ldp j Browse F

LCancel

\ [18Dec 2003 [15:22.43

Figure 5-24. Program Tab Settings

4. Click Load and wait until 100% of the files load into your
receiver (Figure 5-25).

ETPS Firmware Loader: Device = Receiver

File Optionz Help

Cornection | Device F‘rograml

Capture Method: ISoft Break Capture b

7 RAM file: [E-\. ABUhgdl 013\btoader Idh =] Browss Rl

= Flagh file: |E:\.. “Firmware and loaderibt_hgd|_0134btmain.ldp j Browse F

Lancel
100%

|Loading completed [19Dec 2003 [15:28.33

Figure 5-25. Bluetooth Firmware Load Complete

displays at the bottom of the dialog box. Select the

@ If you selected an incorrect file, an error message
correct file.

5. Click File » Exit.
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Troubleshooting

This chapter helps you diagnose and solve some common problems
you may encounter with your receiver.

Ml

0

.'A'

ARNI

NG )

Do not attempt to repair equipment yourself. Doing
so will void your warranty and may damage the
hardware.

Check This First!

Before contacting Topcon support, check the following:

 Check all external receiver connections carefully to ensure
correct and secure connections. Double check for worn or
defective cables.

* Check all power sources for drained batteries or incorrectly
connected batteries/cables.

* Check that the most current software is downloaded onto the
computer and that the most current firmware is loaded into the
receiver. Check the TPS website at www.topconpositioning.com
for the latest updates.

* If connecting via Bluetooth, check that the port used for
connection is in Command mode. See page 6-10 for details.

Then, try the following:

 Reset the receiver using PC-CDU (Tools » Reset receiver).

* Restore default settings using PC-CDU (Configuration »
Receiver, then click Set all parameters to defaults).
* Clear the NVRAM (see “Clearing the NVRAM,” on page 5-13).

* Initialize the file system (click Tools » Initialize file system).
This erases all files inside the receiver.

If the problem persists, see the following sections for other solutions.

P/N 7010-0816
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Troubleshooting

Troubleshooting Quick List

For receiver power issues:

If “The receiver does not power up,’ see page 6-3.

For receiver issues:
If “The RX/TX LED is flashing green on my base receiver,” see
page 6-4.
If “There is no radio link between Base and Rover and the RX/
TX LED is flashing green on the rover,” see page 6-4.

If “There is no radio link between Base and Rover and the Rover
RX/TX LED is solid green,” see page 6-4.

If “The RX/TX LED is flashing red on my receiver,” see page 6-
4.

If “The receiver cannot obtain code differential and/or RTK
solutions,” see page 6-5.

If “The receiver cannot establish a connection to a computer or
external controller,” see page 6-5.

If “The receiver does not lock on to satellites for a long period of
time,” see page 6-6.
If “The receiver tracks too few satellites,” see page 6-6.

If “The receiver cannot obtain Code Differential and/or RTK
solutions,” see page 6-7.

If “The receiver does not log data,” see page 6-9.

For Bluetooth connection issues:
If “BTCONF error message: Can’t find receiver,” see page 6-10.

If “BTCONF error message: Can’t find Bluetooth,” see page 6-
11. see page 6-11.

If “BTCONF error message: Open COM# port failed: Access is
denied,” see page 6-12.

If “After searching for available devices, none are discovered,”
see page 6-12.

If “Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it,” see page 6-12.
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For modem issues:

If “Modem-TPS cannot connect to the receiver,” see page 6-13.

Powering Problems

All receivers are preset in the factory to “Auto mode” for both
batteries. To check these settings, use the following procedure:

1. Connect your receiver and computer, and run PC-CDU (see
“Connecting the Receiver and a Computer,” on page 2-14).
Once connected, click Configuration » Receiver.

3. On the General tab, view the Power and Charger fields. These
fields should be set to Auto. If not, change them to Auto, and
click Apply.

| Clearing the NVRAM returns the receiver to Auto
% power mode (see “Clearing the NVRAM,” on

page 5-13).

The receiver does not power up

5> The receiver may be in Zero Power Mode.

* Press the Reset key to return to Normal Mode

= The batteries may be discharged.

* Connect/attach a fully charged battery and retry. See
“Powering the Receiver with an External Battery,” on page 2-
13.

* Charge the batteries overnight. See “Powering the Receiver
with an External Battery,” on page 2-13.
= If using an external power source, the cable may be
disconnected or damaged.
Check that the cable is securely connected and undamaged.

= The receiver may have a defective charger or defective
batteries.
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If, after changing the batteries or connecting an external
power source, the receiver still does not power up, then
contact TPS Customer Support for advice. For more details,
see “Obtaining Technical Support,” on page 6-14.

Receiver Problems

The following are some of the most commonly encountered receiver
problems.
The RX/TX LED is flashing green on my base receiver
The base has been set into Receiver mode, not transmit mode.
Change this using the data collector software or Modem-TPS.
There is no radio link between Base and Rover and the RX/TX
LED is flashing green on the rover

¢ The LED indicates that the receiver is set into Receive mode;
however, no radio link has been established.

* Check to make sure that the base receiver is powered on.
¢ Check to make sure that the base and rover receivers are on
the same channel.
There is no radio link between Base and Rover and the Rover
RX/TX LED is solid green

¢ The LED indicates that the rover has established a radio link
with the base receiver; however, it is not receiving RTK
Corrections.

* Make sure that the base is tracking enough satellites.

* Make sure that the base is transmitting via a radio scanner or
by setting up the base receiver with PC-CDU or application
software.

The RX/TX LED is flashing red on my receiver
* A fault condition has been detected.
* Check the radio modem’s antenna to see if it is undamaged.

* Check to see if the radio antenna is connected properly and
securely.
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The receiver cannot obtain code differential and/or RTK
solutions
= The Base modem output power is disabled.

* Make sure that RF transmit power is enabled using
Modem-TPS or field software (such as TopSURV).

* Using Modem-TPS, check the Radio Link tab to ensure the
radio is configured as a Base radio and the correct Output
Power setting is selected. See “Configuring the Radio
Modem,” on page 3-3 for more details.

= The Base and Rover modems use different radio link
parameters.

» Configure the Base and Rover radio modems according to
the procedures listed in the applicable section.

* For details on a Satel radio modem, see “Configuring the
Radio Modem,” on page 3-3.

The receiver cannot establish a connection to a computer or
external controller

Cable specific problems:

= The serial/USB cable is not properly plugged in.

¢ Check that the cable connector is attached to the correct
receiver port on the computer.

* Unplug the cable, then securely and properly reconnect it to
the receiver.

* See “Getting Acquainted,” on page 1-7 and “Connector
Specifications,” on page A-12 for information on the
receiver’s connectors.

= The serial/USB cable is damaged.

Use an undamaged cable. Contact your Dealer to replace the
cable.

Generic problems:

= The receiver port used for connection is not in Command mode.
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1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer,” on
page 2-14) and start PC-CDU.

Click Configuration » Receiver » Ports.

3. Change the Input for the port used for connection to
“Command.”

The receiver does not lock on to satellites for a long period of
time
5> The receiver stores an old almanac.

Update the almanac. See “Collecting Almanacs and
Ephemerides,” on page 2-21 for details.

= The corresponding receiver options may be disabled or expired
(L1/L2, GPS/GLONASS must be on to track satellites).

* See “Managing Receiver Options,” on page 5-10 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website at
www.topconpositioning.com for details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.
The receiver tracks too few satellites

= The elevation mask value is too high (above 15 degrees).
Lower the elevation mask. See “MINTER Configuration,” on
page 3-17 for information on setting the elevation mask.
= The survey is conducted near obstructions (tree canopy, tall
buildings, and so forth).
* Make sure the Multipath Reduction boxes are enabled.

1. Connect your receiver and a computer, and start
PC-CDU. See “Connecting the Receiver and a
Computer,” on page 2-14.
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2. Click Configuration » Advanced and the Multipath
Reduction tab. Enable the two boxes, and click
Apply.
* Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK
solutions

= Incorrect Base coordinates entered.

Specify the correct coordinates for the Base station using
PC-CDU or another suitable field data collection software.

= The receiver is not configured as a Base or Rover.

« If the receiver should function as a Base, ensure it has the
proper configuration. See Chapter 3 for details.

e If the receiver should function as a Rover, ensure it has the
proper configuration. See Chapter 3 for details.

= The corresponding receiver options may be disabled or expired.

* See “Managing Receiver Options,” on page 5-10 for details
on how to check current options.

* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website at
www.topconpositioning.com for details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

= There are not enough common satellites. In order to obtain a
fixed solution, the Base and Rover should track at least five
common satellites.

* Ensure that both the Rover and Base receivers use the
same, and updated, almanac. See “Collecting Almanacs
and Ephemerides,” on page 2-21.

* Check the elevation masks of the Rover and Base receivers;
they should be the same. See “MINTER Configuration,” on
page 3-17 for information on setting the elevation mask.
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= A discrepancy exists between the differential standards used at
the Base and Rover receivers.

Ensure the Base and Rover receivers use the same corrections
input/output format:

1. Connect your receiver and a computer, and start PC-
CDU. See “Connecting the Receiver and a Computer,” on
page 2-14.
2. Click Configuration » Receiver and the Ports tab. Use
the same input/output format for both receivers.
& Poor satellite geometry (PDOP/GDOP values are too high).

Conduct your survey when PDOP values are low.

= The elevation mask is above 15 degrees.
Lower the elevation mask. See “MINTER Configuration,” on
page 3-17 for information on setting the elevation mask.

= The modem battery is low.

» Attach an external power source to the receiver. See
“Powering the Receiver with an External Battery,” on
page 2-13.

* See also “Charging the Internal Batteries,” on page 2-7.

= The transmitting and/or receiving antenna may be improperly
connected.

* Check that the radio modem’s antenna is securely and
properly connected to the antenna connector.

* Check that the radio modem’s antenna is undamaged. If
damaged, contact your TPS dealer to replace the antenna.

= The specified baud rate is incompatible with the baud rates the
modem supports.

The baud rate is the rate at which the receiver transmits
differential messages to the modem and vice versa.

Change the baud rate to that which your modem supports.
Refer to the modem’s manual for information.
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= The Base and Rover modems use different radio link
parameters.

Configure the Base and Rover radio modems according to the
procedures listed in the applicable section.

* For details on a configuring a Satel radio modem, see
“Configuring the Radio Modem,” on page 3-3.
5> The distance between the Base and Rover is too far.

* Close the distance between the Base and Rover. The
reliable radio range of the HiPer Ga/Gb is 2—4 miles
(3.22-6.44 km). This range varies greatly depending on the
power of transmitter, radio antenna height, surrounding
radio and natural environments.

» Use repeaters to increase radio coverage.

= There may be a source of radio interference that disrupts radio
communications.

* Change the RF channel (if possible).

» Use a spectrum analyzer to detect the radio characteristics
of the interfering signal and change your system’s
configuration accordingly.

* Remove the source of jamming signal or relocate your
radio antennas (if possible).

The receiver does not log data

= The memory option is disabled or expired.
* Check that the memory option is enabled. For details, see
“Checking the Receiver’s OAF,” on page 5-10.
= The receiver’s memory has no free space.

* Download and/or delete data files to free up space for new
files (see “Downloading Files to a Computer,” on page 5-1.

e Use the AFRM feature. See “Automatic File Rotation
Mode (AFRM) parameters,” on page 3-21.
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Bluetooth Problems

The following are some of the most commonly encountered error
messages and other problems.

BTCONF error message: Can’t find receiver

= The receiver is turned off.

Ensure the receiver has power and is turned on.

= If using a cable, the cable’s connectors are improperly attached.

¢ Check that the cable connector is attached to the correct
serial/USB port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.
= If using a cable, the cable is damaged.

* Use an undamaged cable.
* Contact your TPS dealer to purchase a new cable.

= The COM port the receiver is attached to differs from the one
selected in BTCONE.

* Ensure that the RS232 cable is attached to the COM port
specified in the BTCONF communication port list.

* See “Bluetooth Module Configuration,” on page 2-17 for
details.
> The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer,” on
page 2-14) and start PC-CDU.

Click Configuration » Receiver » Ports.

3. Change the Input for the serial port used for connection
to “Command.”

| This is the most common cause for this error
% message. Use PC-CDU to double check the settings

for the connection port.
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= The settings for Port B may have been changed.

* The settings for Port B are: 115200 baud rate, 8 data bits, 1
stop bit, no parity, and no handshaking.

* Try enabling RT'S/CTS handshaking for Port B. Do not
change other settings.

= The corresponding receiver options may be disabled or expired
(serial port B must be enabled).

* See “Managing Receiver Options,” on page 5-10 for details
on how to check current options.

* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website at
www.topconpositioning.com for details.

* Refer to the PC-CDU Reference Manual for a detailed
description of options.
BTCONF error message: Can’t find Bluetooth
5> The receiver’s Slot 3 is turned off.
1. See “Establishing an RS232 Cable Connection,” on
page 2-16 to connect the computer and receiver.
. Click Configuration » Receiver » General.
3. In the Turn on/off Slots area, enable the Slot 3 (B) check
box.
= The Bluetooth module is linked with another device.
Close the connection with the device, then connect to your
receiver.
= The receiver does not have a Bluetooth module.

* Continue with other configuration/survey functions using a
serial or USB cable.

* Contact your TPS dealer to purchase a Bluetooth enabled
receiver.
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= The Bluetooth module’s processor is overloaded.
1. Put your receiver in Zero Power Mode. See “Entering
Zero Power Mode,” on page 5-16 for details.

2. Press the Reset key for about one second to return the
receiver to normal mode.

3. Reconnect to the Bluetooth module.

BTCONF error message: Open COM# port failed: Access is
denied

= Another application uses the computer port dedicated for
connection.

* Close the application, then reconnect.

* Connect the receiver via another unused computer port.
After searching for available devices, none are discovered

> The receiver is not receiving power.
* Check that the receiver is getting power and is turned on.

* Check that the power cable is attached to the port marked
‘6PWR.”

* Unplug the cable, then securely and properly reconnect it to
the receiver.

* If the power cable is damaged, contact your Dealer to
purchase a new cable.
5> The receiver’s Slot 3 is turned off.

1. Connect your receiver and a computer using an RS232
cable (see “Establishing an RS232 Cable Connection,” on
page 2-16).

Click Configuration » Receiver » General.
In the Turn on/off Slots area, enable the Slot 3 (B) check
box.

Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it

5 Device security settings probably differ.
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* Make sure your Bluetooth enabled devices use the same
security settings.

* See “Bluetooth Module Configuration,” on page 2-17 for
details on changing security settings.
= Bluetooth module settings may have changed.

1. If you changed settings for your Bluetooth module,
remove it from the list of discovered Bluetooth devices
using the Bluetooth manager program (supplied with the
device used to manage the receiver).

2. Repeat the search.

Modem-TPS Problems

The following is the most commonly encountered Modem-TPS
problem.

Modem-TPS cannot connect to the receiver

= The receiver is turned off.

Ensure the receiver has power and is turned on.

= If using a cable, the cable’s connectors are improperly attached.

¢ Check that the cable connector is attached to the correct
serial port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.
> If using a cable, the cable is damaged.
* Use an undamaged cable.
* Contact your Dealer to purchase a new cable.

= If using Bluetooth wireless technology, the incorrect port is
selected, or the receiver or computer does not support
Bluetooth.

» Use a computer or receiver that has Bluetooth wireless
technology enabled/installed.
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* Check that the computer and receiver use the correct ports
for communication. For the HiPer Ga/Gb receiver, this is
port A.

= The corresponding modem options may be disabled or expired.

* See “Managing Receiver Options,” on page 5-10 for details
on how to check current options.

* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website at
www.topconpositioning.com for details.

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

= The type of radio modem is disabled for detection using
Modem-TPS.

1. Click Cancel on the Connection dialog box or Stop on
the Connecting to device dialog box.

In Modem-TPS, click Tools » Options.

3. Enable the modem type installed in the receiver
connected to the computer, and click Ok.

4. Click File » Connect.

Obtaining Technical Support
If the troubleshooting hints and tips in this Operator’s Manual fail to
remedy the problem, contact TPS Customer Support.

Before contacting TPS Customer support about any problems with
the receiver, see “Check This First!,” on page 6-1 for some solutions
that may fix the issue.
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Obtaining Technical Support

Phone

To contact TPS Customer Support by phone, call:

1-866-4TOPCON (1-866-486-7266)
Monday through Friday
7:00 a.m. to 5:00 p.m., Pacific time

To contact TPS Customer Support via e-mail, use one of the
following electronic mail addresses (Table 6-1).

Table 6-1. Technical Support E-mail

For Questions Related To... Use...
Hardware (receivers, antennas, firmware) hardware @topcon.com
GPS+ and 3DMC psg@topcon.com
OAF options @topcon.com
RTK rtk @topcon.com
PC-CDU pccdu@topcon.com
If in doubt... support@topcon.com

! For quick and effective support, provide a detailed
description of the problem.

When e-mailing TPS customer support, provide the following
information for better, faster service:

1.

The receiver model and configuration settings.

In PC-CDU, click Help » About, and click Save to file. Enter a
name for the file, and save it to your computer. Attach this file to
the e-mail.

The system/hardware specifications for the computer running
PC-CDU; such as operating system and version, memory and
storage capacity, processor speed, and so forth.

The symptoms and/or error codes/messages that precede and
follow the problem.
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Troubleshooting

4. The activities being tried when the problem occurs. If possible,
include the exact steps being taken up to when the error message
or other problem occurs.

5. How regularly the problem occurs.

Generally, a customer support representative will reply within 24
hours, depending on the severity of the problem.

Website

The Topcon Positioning Systems website provides current
information about Topcon’s line of products. The support area of the
website provides access to frequently asked questions, configuration
procedures, manuals, e-mail support, and so forth.

To access the TPS website, go to www.topconpositioning.com.
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Appendix A

Specifications

This TPS product is a 40-channel GPS+ (GPS and GLONASS)
receiver with an internal Digital UHF radio modem, a Bluetooth®
wireless technology module, and a rugged aluminum housing
complete with MINTER and cable connectors.

GPS satellites above 15 degrees in elevation and
adherence to the procedures recommended in this
manual.

% Performance specifications assume a minimum of 6

In areas of high multipath, during periods of large
PDOP, and during periods of increased ionospheric
activity, performance may degrade.

®

Use robust checking procedures in areas of extreme
multipath or under dense foliage.

)
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Specifications

Receiver Specifications

The following sections provide specifications for the receiver and its
internal components.

General Details
Table A-1 lists HiPer Ga/Gb component details.

Table A-1. Receiver Specifications

Physical
Enclosure Aluminum extrusion, rainproof
Color Topcon Yellow
Dimensions W:159 x H:88 x D:172 mm
Weight 1.74 kg
Antenna Internal
Battery Two internal
Controller External
Mounting 5/8-11
Seals Silicon (molding in Color)
Keys Three keys:
Power — On/Off
Function (FN) — start/stop data logging; switch
information mode.
Reset — receiver hardware reset
LEDs Four LEDs:
STAT - satellite and receiver status
REC - record and data status
BATT - battery status
RX — modem status
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Receiver Specifications

Table A-1. Receiver Specifications (Continued)

Environment

Operating
temperature

-30 C° to + 60 C° with batteries

Storage temperature

-40 C° to +75 C° with batteries

Humidity

95%

Power

Internal battery

Li-ion, 4000 mAh, 7.4 V
Not removable

Battery size

132 x 35 x 18 (mm)

Battery weight

165 g (1 battery)

Number of built-in
batteries

2 batteries

Operating time

With TX mode ON (1W):
~8 hours
With RX mode ON:
~10 hours
With radio in STANDBY mode:
~13 hours
With radio OFF:
~16 hours

External power

1 port

Input voltage

6 to 28 V DC (for work)
9 to 28 V DC (for charge battery)

Minimum Charge Current < 2 Amp

Consumption ~5 W in TX mode (1W)
~1.25 W in RX mode
~.05 W in Standby mode
~3.3 W with radio off
On-board Backup battery for timekeeping and almanac data storage;

10 years minimum operation
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Specifications

Table A-1. Receiver Specifications (Continued)

/10

Communication Up to four high speed RS232 serial ports, a USB port, and
Ports an internal Bluetooth communication port.

Connectors Modem Antenna, PWR, USB

MINTER Four external LEDs

ON/OFF control input

Data Features

Up to 20 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models

RAIM

Different DATUMs support

Output of grid coordinates

CMR and CMR+ support

Technology
Co-Op tracking
Low signal tracking
Advanced Multipath mitigation
WAAS
Adjustable PLL and DLL parameters
NMEA
NMEA version Ver. 2.1, 2.2, 2.3, 3.0 output
Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC,

VTG, ZDA, ROT, GMP

Output interval

1Hz standard; 5, 10, 20Hz optional
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Receiver Specifications

Table A-1. Receiver Specifications (Continued)

DGPS

Correction format

RTCM SC104 Ver 2.1, 2.2, 2.3, and 3.0

RTCM message
type

1, 3,9, 31, 32, 34; user selectable

Process interval

1Hz standard; 5, 10, 20Hz optional

Output interval for
RTCM correction
data

1Hz standard; 5, 10, 20Hz optional

Elevation mask

0 to 90 deg (independent of data logging)

Multi-base DGPS

Differential correction select mode: Nearest, Mix, Best
(optional)

RTK

Correction format

CMR2/CMR+ (Trimble compatible), RTCM SC104 Ver
2.1,2.2,2.3,0r 3.0

RTCM message
type

3,18, 19, 20, 21, 22; user selectable

Ambiguity initialize

OTF (L1, L1/L2)

Initialize time

5 seconds to 10 min depending on the base line length and
multipath conditions

Output interval for
CMR/RTCM

1Hz standard; 5, 10, 20Hz optional

Elevation

0 to 90 degrees (independent of data logging)

Solution mode

Delay (synchronization)
Extrapolation (not synchronized)

Process interval

1Hz standard; 5, 10, 20Hz optional

Latency Delay mode — 20 msec to 20 sec (depends on latency
which receives corrections data from base receiver)
Extrapolation — 20 to 30 msec

Raw Data logging The receiver can record raw data at another interval during

RTK operation
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Specifications

Table A-1. Receiver Specifications (Continued)

Status Fix, Float, DOP, Data Link Status, Modem Latency,
Common satellites, Percentage of fixing

Results RTK coordinates, HRMS, VRMS, Covariance Matrix

Ambiguity fixing Selectable thresholds

level

Low: 95%; Medium: 99.5%; High: 99.9%

Survey Modes

Base or Rover

Static

Kinematic (Stop and Go)
RTK (Real-time Kinematic)
DGPS (Differential GPS)
WASS/EGNOS DGPS

Survey Accuracy

Static, Fast Static

For L1+L2 — H: 3mm + 0.5ppm (x baseline length);
V: Smm + 0.5ppm (x baseline length)

Kinematic, RTK

For L1+ L2 — H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)

DGPS <lm
Cold Start < 60 sec
Warm Start < 10 sec
Reacquisition <1 sec
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Receiver Specifications

GPS Board Details
Table A-2 lists the GPS board’s general specifications.

Table A-2. GPS Board Specifications

Receiver Type (set

by activating the proper OAF)

Euro-112T
(HGGDT)

G: GPS L1

GD: GPS L1/L2

GG: GPS/GLONASS L1
GGD: GPS/GLONASS L1/L2

Tracking Specifica

tions

Standard Channels

40 channels (G, GG, GD, GGD)

L1 GPS, L1/L2 GPS, L1 GLONASS, L1 GPS + L1
GLONASS, WAAS/EGNOS, PCode and Carrier

Optional

Cinderella days (see page A-8 for details)

Tracked Signals

GPS/GLONASS, L1/L2 C/A and P-Code and Carrier,
WAAS/EGNOS

Tracking Functions

Multi-path Code and Carrier
reduction
PLL/DLL setting Bandwidth, order, adjustable

Co-op tracking loop
setting

On/Off, S

\tatic Mode, Bandwidth of individual PLL, Bandwidth of
common PLL

Smoothing interval

Code and Carrier

WAAS/EGNOS

WAAS optional
EGNOS optional

Data Features

Formats

TPS, NMEA, RTCM, BINEX
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Specifications

Table A-2. GPS Board Specifications (Continued)

Features Up to 20 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O

Features Multiple Base RTCM
(continued) Geoid and Magnetic Variation models
RAIM

Different DATUMs support
Output of grid coordinates
CMR and CMR+ support

Memory
Internal Memory Compact flash card (not removable)
Capacity Standard — 0 MB
Max — 128 MB
Logging Time 53 hours (8 MB, 15sec, L1/L2, 7 satellites)
Logging Interval 0.05 to 86400 seconds, depending on purchased options

Cinderella days is an option that turns a single frequency, GPS
receiver into a dual-frequency, GPS+GLONASS receiver for 24 hours
every other Tuesday at GPS midnight. Refer to Topcon’s website at
www.topconpositioning.com for more information and specific
Cinderella day dates.

Bluetooth Module Details

Table A-3 lists the Bluetooth wireless technology module’s general
specifications.

Table A-3. Bluetooth Module Specifications

BlueTooth™ + 2.0+EDR EDR

Point- to-point or point to multi point

Radio frequency Power class 2
module
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Receiver Specifications

Table A-3. Bluetooth Module Specifications (Continued)

Frequency 2400 — 2483.5 MHz
Power -6 - +4 dBm
Supported profiles LM, L2CAP, SDP, PPP

Digital UHF Modem General
Specifications

Table A-4 lists the Digital UHF modem’s general specifications.
Table A-4. HiPer Ga/Gb Modem General Specifications

Parameter Specification
Operating frequency range 410-470 MHz
Modulation Technique DBPSK, DQPSK, D8PSK, D16QAM,4LFSK
Occupied Bandwidth 12.5 kHz
(Channel Spacing) 25 kHz @ 4LFSK modulation only

Data Rate (@12.5 kHz
Channel Spacing)

9600 bps — DQPSK/4LFSK
14400 bps — D8PSK
19200 bps - D16QAM

Data Rate (@25kHz Channel
Spacing)

19200 bps - 4L FSK

IPower Consumption

System Gain 146 dB (Antennagain not included)
Roaming Speed 60 mph / 96km/h
[End to End delay 60 ms

<4.5W — 1 Watt continuos transmitting mode
<2.5W — transmit with 30% duty cycle (1 Watts
Output)

<1.6W — transmit with 10% duty cycle (1 Watts
Output)

<3.0W — 0.5 Watt continuos transmitting mode
<1.8W — transmit with 30% duty cycle (0.5 Watts
Output)

<1.4W — transmit with 10% duty cycle (0.5 Watts
Output)

<1.2W —receive mode

[Electromagnetic Compliance

0.05W — standby mode

[FCC Part 90, ETSI EN300113-2V1.5.1
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Digital UHF Transmitter

Specifications

Table A-5 lists the Digital UHF Transmitter’s general specifications.

Table A-5. Digital UHF Transmitter Specifications

Parameter

Selection

Output power

10 dBm to 29 dBm in 1 dB steps)

Output Power Control Accuracy

*1 dB (at normal test conditions)

+2.0 dB and -3.0 dB (under extreme test
conditions)

Nominal Output Impedance

50 Ohms 2.0:1 VSWR

Carrier Frequency Stability

% 1.5 ppm initial stability over temp with
13 ppm aging/year

Max. Frequency Error

+1.0 kHz (at normal test conditions)

1.5 kHz (under extreme test
conditions)

Adjacent Channel Power (Conducted)

60 dBc

Spurious Emission (Conducted)

-36 dBm @(9 kHz - 1 GHz)
-30 dBm @(1 GHz — 4 GHz)

Spurious Emission (Radiated)

-36 dBm @(9 kHz — 1 GHz)
-30 dBm @(1 GHz - 4 GHz)

Intermodulation Attenuation

<65 dBc

Type of Emission

FCC Part 90
§90.210(d)

ETSI EN 300-113-1 V1.5.1
Clause 5.1.4
Clause 8.6.1
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Receiver Specifications

Digital UHF Receiver Specifications

Table A-6 lists the Digital UHF Receiver’s general specifications.

Table A-6. Digital UHF Receiver Specifications

<1x10"*, over temperature -30°C to
+60°C)

Parameter Specification
Noise Figure 5dB
Nominal Input Impedance 50 Ohms
Receiver sensitivity for DBPSK (@ BER |-116 dBm

Dynamic Range

-119 to -34 dBm

Max. Input Signal Level -10 dBm
Co-channel Rejection -12dB
Adjacent Channel Selectivity -60 dB
Spurious Radiations <2nW

Environmental Specifications

Table A-7 lists the receiver’s general environmental specifications.

Table A-7. HiPer Ga/Gb Environmental Specifications

Parameter

Specification

Temperature

Operation:
-30°C to +60°C

Storage:
-40°C to +85°C

Humidity

Min 5 cycles / 1 cycle=48h
Max 600C, max RH95% operating
Max 650C, RH% (none operating)

Altitude

-1000m under sea level or 8500m above
sea level
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Specifications

HiPer Ga/Gb Compliance

Table A-8 lists the receiver’s compliance specifications.
Table A-8. HiPer Ga/Gb Compliance

Parameter Specification
ETSI ETSI 300-113--1V
FCC FCC Part 90
Industry Canada RSS-210
UL UL1419

UL Hazardous Location

Class1, Div 2, Groups A, B, C, and D
hazardous locations

FM

Approved

Connector Specifications

The following sections list HiPer Ga/Gb connector details.

Radio (Modem) RF Connector
The Satel (UHF) modem connector type (Table A-9) is a BNC female

RF connector.

Table A-9. UHF Modem Connector Specifications

Type Signal Name

Dir

Details

BNC Modem I/O

1/0

RF output from modem antenna
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Connector Specifications

Power Connector

The power connector (Figure A-1) is a sealed receptacle, 5 pin, ODU
part number 23-000009-02.

Figure A-1. Power Connector

Table A-10 gives power connector specifications.

Table A-10. Power Connector Specifications

Number Signal Name Dir Details
1 Power_INP P 6 to 28 volts DC input
2 Power_INP P 6 to 28 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Not used
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Specifications

Serial C-RS232 Connector

For ports A and D. The RS232 connectors (Figure A-2) are sealed
receptacle, 7 pin, ODU part number 23-000008-02.

Figure A-2. RS232 Connector

Table A-11 gives the RS232 cable connector specifications.

Table A-11. RS232 Connector Specifications

Number Signal Name Dir Details
1 Power_OUT P Power Output
(Supplied Voltage)
2 GND - Signal ground
3 CTS I Clear to send
4 RTS (0] Request to send
5 RXD I Receive data
6 TXD (6] Transmit data
7 Not used
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Connector Specifications

USB Connector

The USB connector is a sealed receptacle, 5 pin TPS cable connector
(Figure A-3).

Figure A-3. USB Connector for GGD Options

Table A-12 gives the USB connector specifications.

Table A-12. USB Specifications

Number Signal Name Dir Details
1 Not used
2 USB_PWR P Bus power input
3 GND - Ground
4 USB D+ 1/0 Data plus
5 USB D- 1/0 Data minus
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Notes:

A-186 HiPer Ga/Gb Operator’s Manual



Appendix B

Safety Warnings

General Warnings

ST

To comply with RF exposure requirements,
maintain at least 25cm between the user and the
radio modem.

il

[WARNI

NG )

TPS receivers are designed for survey and survey
related uses (surveying coordinates, distances,
angles and depths, and recording such
measurements). This product should never be used:

Without the user thoroughly understanding this
manual.

After disabling safety systems or altering the
product.

With unauthorized accessories.
Without proper safeguards at the survey site.

Contrary to applicable laws, rules, and
regulations.

S

TPS receivers should never be used in dangerous
environments. Use in rain or snow for a limited
period is permitted.
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Safety Warnings

Battery Pack Warnings

degrees fahrenheit (100 degrees celsius). Excessive
heat can cause serious damage and possible
explosion.

@ Do not incinerate or heat battery pack above 212

_{.n. Tampering with the batteries by end users or non-
N factory authorized technicians will void the
USLILD)  battery’s warranty.

* Do not attempt to open the battery pack or
replace it.

* Do not disassemble the battery pack.

* Do not charge in conditions different than
specified.

* Do not use other than the specified battery
charger.

* Do not short circuit.
* Do not crush or modify.

'ﬂT This product contains a CR Lithium Battery which
N contains Perchlorate Material - special handling
[WARNING ) may apply

See http://www.dtsc.ca.gov/hazardouswaste/
perchlorate/

Note: This is applicable to California, USA only.
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Usage Warnings

Usage Warnings

Ml

[WARNING )

Handling the cord on this product, or cords
associated with accessories sold with this product,
will expose you to lead, a chemical known to the
State of California to cause birth defects or other
reproductive harm. Wash hands after handling.

e

If this product has been dropped, altered,
transported or shipped without proper packaging, or
otherwise treated without care, erroneous
measurements may occur.

The owner should periodically test this product to
ensure it provides accurate measurements.

Inform TPS immediately if this product does not
function properly.

Only allow authorized TPS warranty service centers
to service or repair this product.
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Safety Warnings

Notes:
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Appendix C

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations for use.

UHF Radio Usage

@ Using a UHF radio requires a license. Operating a

UHF radio without a license may result in fines or
other penalties. Be sure you comply with all local
laws before operating a UHF radio. Contact your
local authorities (such as, the FCC in the United
States) for details.

Surveying in RTK mode has made UHF the most popular choice for
communications between Base and Rover receivers. Know the
strengths and weaknesses of this technology to get the best use out of
your receiver. The quality and strength of the UHF signals translates
into range for UHF communications.

1. The system’s range will greatly depend on the local conditions.
Topography, local communications and even meteorological
conditions play a major role in the possible range of RTK
communications. If needed, use a scanner to find clear channels.

2. The system’s range will increase by adjusting the Base station’s
antenna using the following methods.

» Ensure the Base radio has a fully charged battery.

* Use directional antennas and/or repeaters to increase your
system’s range. Directional antennas concentrate the signal
power within a more narrow direction, significantly
increasing the range of your system.
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Regulatory Information

* Check the TPS accessory line for items to raise the Base
radio.

FCC Compliance

This equipment complies with FCC radiation exposure limits set forth
for uncontrolled equipment and meets the FCC radio frequency (RF)
Exposure Guidelines in Supplement C to OET65. This equipment has
very low levels of RF energy that it deemed to comply without
maximum permissive exposure evaluation (MPE). But, it is desirable
that it should be installed and operated at a minimum distance of at
least 20cm between the radiator and person’s body (excluding
extremities: hands, wrists, feet, and ankles).

This device complies with Part 15 of the FCC rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits
for a digital device, pursuant to Part 15 of the FCC rules. These limits
are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates,
uses, and can radiate radio frequency energy, and if not installed and
used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation.

If this equipment does cause interference to radio or television
equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that
to which the receiver is powered.
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Community of Europe Compliance

* Consult the dealer or an experienced radio/television technician
for additional suggestions.

Any changes or modifications to the equipment not
@ expressly approved by the party responsible for

compliance could void your authority to operate
such equipment.

Community of Europe
Compliance

The product described in this manual is in compliance with the
R&TTE and EMC directives from the European Community.

Canadian Emission Labeling
Requirements

1. Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.

2. To reduce potential radio interference to other users, the antenna
type and its gain should be so chosen that the equivalent
isotropically radiated power (e.i.r.p.) is not more than that
permitted for successful communication.

3. This Class B digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte conform a la norme
NMB-003 du Canada.
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Regulatory Information

WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be
treated as household waste. By ensuring this product is disposed of
correctly, you will help prevent potential negative consequences for
the environment and human health, which could otherwise be caused
by inappropriate waste handling of this product. For more detailed
information about the take-back and recycling of this product, please
contact your supplier where you purchased the product or consult.

Industry Canada Compliance

RF Radiation Hazard Warning

To ensure compliance with Industry Canada RF exposure
requirements, this device must be installed in a location where the
antennas of the device will have a minimum distance of at least 20 cm
from all persons. Using higher gain antennas and types of antennas
not certified for use with this product is not allowed. The device shall
not be co-located with another transmitter.

Installez l'appareil en veillant a conserver une distance d'au moins 20
cm entre les éléments rayonnants et les personnes. Cet avertissement
de sécurité est conforme aux limites d'exposition définies par la
norme CNR-102 at relative aux fréquences radio.
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Industry Canada Compliance

Maximum Antenna Gain

This radio transmitter has been approved by Industry Canada to
operate with the antenna types listed below with the maximum
permissible gain and required antenna impedance for each antenna
type indicated. Antenna types not included in this list, having a gain
greater than the maximum gain indicated for that type, are strictly
prohibited for use with this device.

Le présent émetteur radio a été approuvé par Industrie Canada pour
fonctionner avec les types d'antenne énumérés ci-dessous et ayant un
gain admissible maximal et I'impédance requise pour chaque type
d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le
gain est supérieur au gain maximal indiqué, sont strictement interdits
pour l'exploitation de I'émetteur.

LAIRD G450BN 450-470 MHz 2.5 dB 1/2 WV 8.5" PVC Portable
Ant, BNC Conn

Industry Canada Notice and Marking
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-
003 du Canada.

The term “IC:” before the radio certification number only signifies
that Industry Canada technical specifications were met.

Under Industry Canada regulations, this radio transmitter may only
operate using an antenna of a type and maximum (or lesser) gain
approved for the transmitter by Industry Canada. To reduce potential
radio interference to other users, the antenna type and its gain should
be so chosen that the equivalent isotropically radiated power (e.i.r.p.)
is not more than that necessary for successful communication.

Conformément a la réglementation d'Industrie Canada, le présent
émetteur radio peut fonctionner avec une antenne d'un type et d'un
gain maximal (ou inférieur) approuvé pour I'émetteur par Industrie
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Regulatory Information

Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le
type d'antenne et son gain de sorte que la puissance isotrope rayonnée
équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire a
I'établissement d'une communication satisfaisante.

This device complies with Industry Canada licence-exempt RSS
standard(s). Operation is subject to the following two conditions: (1)
this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada
applicables aux appareils radio exempts de licence. L'exploitation est
autorisée aux deux conditions suivantes : (1) I'appareil ne doit pas
produire de brouillage, et (2) l'utilisateur de 1'appareil doit accepter
tout brouillage radioélectrique subi, méme si le brouillage est
susceptible d'en compromettre le fonctionnement.
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Appendix D

Warranty Terms

TPS laser and electronic positioning equipment are guaranteed
against defective material and workmanship under normal use and
application consistent with this manual. The equipment is guaranteed
for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original

purchaser by TPS’ Authorized Dealers.!

During the warranty period, TPS will, at its option, repair or replace
this product at no additional charge. Repair parts and replacement
products will be furnished on an exchange basis and will be either
reconditioned or new. This limited warranty does not include service
to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized TPS warranty
service dealer. If this product is delivered by mail, purchaser agrees to
insure the product or assume the risk of loss or damage in transit, to
prepay shipping charges to the warranty service location and to use
the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/
or defect.

The purchaser’s sole remedy shall be replacement as provided above.
In no event shall TPS be liable for any damages or other claim
including any claim for lost profits, lost savings or other incidental or
consequential damages arising out of the use of, or inability to use,
the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90
days.
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